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1▼  ▼  ▼  ▼
Getting Started
This Array Management Guide explains how to create and manage 
arrays using the software included with your Adaptec® 
Array1000CA2 Family adapter. It includes instructions on using all 
the software features and also information on how to replace drives, 
reconstruct arrays, etc. To learn how to install the software (includ-
ing drivers) on your computer, see the Installation and Hardware 
Guide for your adapter. The Array1000CA2 Family includes the fol-
lowing adapters:

■ The ARO™-1130CA2 RAID Option Card is a RAID co-proces-
sor card for systems and motherboards that include a 
RAIDport III or RAIDport II connector and one or more 
Adaptec UltraSCSI ASICs on the motherboard. The 
ARO-1130CA2 upgrades UltraSCSI channels on the mother-
board to Adaptec RAID. The ARO-1130CA2 card itself has no 
internal or external SCSI connectors.

■ The AAA™-131CA2 Ultra Wide SCSI RAID card is a single-
channel card with 50-pin and 68-pin internal connectors and a 
68-pin external connector.

Array Management Software Overview
Here is a brief description of the array management software 
included with your Adaptec Array1000CA2 Family adapter:

■ ArrayConfigCA2™ - If you need to re-create arrays, you can 
use the ArrayConfigCA2 program to create the first array in 
your desktop system. ArrayConfigCA2 has a convenient 
Express Setup wizard that asks you a few simple questions and 
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then creates a 2-disk array that best fits your requirements. 
(There is also a Custom Setup option for advanced users.) 
ArrayConfigCA2 runs from a self-booting diskette and is docu-
mented in Chapter 2 of this manual.

■ Adaptec CI/O Management Software - You use this full-fea-
tured program to create, monitor, and manage arrays on your 
desktop system. Adaptec CI/O Management Software also 
enables you to tune and monitor the data input/output perfor-
mance of arrays. This program is documented in Part 3 (Chap-
ters 3 through 7) of this manual.

Using the Array Management Software
Here are some general comments on how to use the Adaptec array 
management software most effectively:

■ Use ArrayConfigCA2 to create (or re-create) the first array on 
your computer. We recommend that you use the convenient 
Express Setup wizard. If you want the fastest possible data 
input and output from the array, select Optimized for Perfor-
mance in Express Setup. If your main concern is protecting the 
data on the array from disk failure, select Optimized for Data 
Protection.

■ Use Adaptec CI/O Management Software to create (or re-cre-
ate) additional arrays and to monitor the performance and sta-
tus of arrays and other devices in your computer.

■ If your arrays are Optimized for Data Protection, you should 
use Adaptec CI/O Management Software to create spare disks 
for the arrays.

■ Use Adaptec CI/O Management Software to test fault-tolerant 
arrays and spares. You should respond immediately to arrays 
that are in Critical status, and you should replace failed disks 
promptly.

■ Use the password feature of Adaptec CI/O Management Soft-
ware to protect your system configuration.
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Conventions and Advisories
This document uses the following typographic conventions:

bold
Used for key names (… press the Enter key …) and for options 
you are told to select (… select Create Array…).

Helvetica
Used for screen messages (…Save changes?…) and for text 
that must be typed exactly as shown.

Helvetica Italics
Used for program and file names when referenced in the text 
(… these changes are made to the config.sys file…).

This document uses the following kinds of advisories:

Note: This kind of advisory presents reminders, tips, or sug-
gestions for using the array management software.

Caution: This kind of advisory cautions you about actions 
that could destroy data or damage the computer system.

WARNING: Failure to observe this kind of advisory could 
result in personal injury.

Use caution when handling any electrical equipment. Advisories in 
this document can only cover the procedures contained here, and 
not all situations may have been addressed. Adaptec does not claim 
to have included every condition or situation that might require a 
Caution or Warning. You must refer to the documentation for your 
computer and peripheral devices when you are installing equipment 
or changing its configuration.

❒
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2▼  ▼  ▼  ▼
Using the ArrayConfigCA2 
Program
This chapter explains how to use the ArrayConfigCA2 program to 
create arrays on your desktop system.You can use ArrayConfigCA2 
in two ways:

■ Choose Express Setup if you want to create an array quickly 
and easily. ArrayConfigCA2 asks you a few simple questions 
and uses your answers to create the kind of array that best 
meets your needs.

■ Choose Custom Setup if you want to have more control over 
the array configuration or if you want to add spare disks to the 
array.

ArrayConfigCA2 runs from a convenient, self-booting diskette. 
Nearly all ArrayConfigCA2 functions can also be performed with 
Adaptec CI/O Management Software, which runs under 
Windows NT.

See the Installation and Hardware Guide for your adapter for informa-
tion on connecting SCSI devices, installing software, preparing to 
run ArrayConfigCA2, and creating your first array with 
ArrayConfigCA2.
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Creating an Array with Express Setup
The ArrayConfigCA2 Express Setup wizard allows you to quickly 
create an array in your desktop system by answering some basic 
questions about what kind of array you want. When you use the 
Express Setup wizard you do not need to know the technical details 
of how arrays are configured.

Follow these steps to create an array with the Express Setup. (You 
can probably complete the Express Setup process by simply follow-
ing the instructions that appear on the screen.)

Note: To select ArrayConfigCA2 menu options, type the hot 
key—the letter that appears in a different color. (The hot key 
letters are underlined in the following instructions). You can 
also press the ↑ and ↓ keys until the option is highlighted 
and then press Enter.

1 Insert the ArrayConfigCA2 diskette in drive A and reboot your 
desktop system. Wait until ArrayConfigCA2 starts automati-
cally.

2 Read the text that appears on the initial ArrayConfigCA2 
screens. Press any key to view the next screen, or press Esc to 
return to the previous screen.

3 When you see the Setup Type Selection Menu, select Express 
Setup.

4 When the next screen appears, select the type of array you 
want to create:

– Select Optimized for Performance if you want the fastest 
possible data input and output from the new array. This 
type of array does not have data protection features, how-
ever; if one disk fails, all data on the array is lost. When 
prompted, type the number of disks you want in this array.

– Select Optimized for Data Protection if your main concern 
is to protect the files on the array from disk failure. This 
type of array safeguards files in the array even if one of the 
array disks fails. (This kind of array has two disks by defi-
nition, so you will not be prompted to enter the number of 
disks you want in the array.)
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5 When the next menu appears, select the type of application 
that you will run on your desktop system. (Select Others if you 
are not sure what type of application you will use.) 
ArrayConfigCA2 will use your answer to create the best array 
configuration for your applications.

6 When the next menu appears, select a boot order for the new 
array.

– Select Disk Array will be Boot Drive (recommended) if 
you want your desktop system to boot from the new array. 
If you selected Optimized for Data Protection in Step 4, 
booting from an array safeguards the information on your 
boot drive. If you selected Optimized for Performance, 
booting from an array improves operating system perfor-
mance. (To boot from an array, you must also install the 
operating system software on the array, as described in the 
Installation and Hardware Guide for your adapter.)

– Select Disk Array will not be a Boot Drive if you do not 
want your desktop system to boot from the new array.

7 When you have finished all these menu selections, wait while 
ArrayConfigCA2 creates the array. This may take a long time 
for large-capacity disks.

A message appears when the array has been created. An error 
message appears if fewer than two disks are available or if 
ArrayConfigCA2 encounters some other problem. If this hap-
pens, install more disk drives or run ArrayConfigCA2 again 
and use the Custom Setup option.
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Creating an Array with Custom Setup
ArrayConfigCA2’s Custom Setup option allows advanced users to 
create arrays with customized configuration and to manage arrays 
that are already created. (You can also perform these advanced 
options with Adaptec CI/O Management Software, which is 
described in Part 2 of this document.) Use Custom Setup if you want 
to

■ delete an array

■ initialize an array

■ add or delete spare disks

■ make an existing array the boot array

Follow these instructions to create an array with Custom Setup.

1 Insert the ArrayConfigCA2 diskette in drive A and reboot your 
desktop system. Wait until ArrayConfigCA2 starts automati-
cally.

2 Read the text that appears on the initial ArrayConfigCA2 
screens. Press any key to view the next screen, or press Esc to 
return to the previous screen.

3 When you see the Setup Type Selection Menu, select Custom 
Setup. Then wait while ArrayConfigCA2 scans your computer 
for information about your host adapter and SCSI devices.

4 When the Main Menu appears, select Disk Array Operations.

5 Select Create New Array from the Disk Array Operations 
menu.

6 Type a name for the array and press Enter. The name can be up 
to 15 characters long and can include spaces and any other 
printable characters.

7 Select an array type from the following options:

– RAID 0: Data is striped across the disks in a RAID 0 array, 
allowing for faster data input and output than a single 
disk. RAID 0 arrays do not store redundant data; if any 
disk in the array fails, all data is lost. (This is the type of 
array that is created if you choose Optimized for Perfor-
mance under Express Setup.)
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– RAID 1: Data is mirrored on one pair of disks. If one disk 
fails, data is still safe. The actual usable data capacity of the 
array equals half the available disk space. (This is the type 
of array that is created if you choose Optimized for Data 
Protection under Express Setup.)

See Selecting a RAID Level for an Array on page 9-7 for more 
information on selecting a RAID level.

8 Type the number of drives you want in the array, not including 
spare drives, and press Enter. The number of drives available 
for assignment is listed on the screen.

Note: This step only applies if you are creating a 
RAID 0 array; RAID 1 arrays have two drives by 
definition.

9 When the next screen appears, select drives for the array by 
pressing the ↑ and ↓ keys until the drive name is highlighted, 
and then press Ins or Enter. The names of selected drives 
appear in the box on the right side of the screen. To deselect the 
drive you most recently added, press Del.

Caution: A warning appears if you select a disk that 
has partitions. Do not select disks with partitions if 
they contain data you want to keep, because any exist-
ing data will be erased when the disk becomes part of 
the array.

When you have selected the number of drives you specified in 
step 8, the next screen appears automatically. If you are creat-
ing a RAID 1 array, and if there are any unassigned drives, the 
screen prompts you to define spare drives for the array.

Note: A spare must have at least the capacity of the 
smallest drive in the array.
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10 If you do not want a spare, type n and continue with step 12. If 
you want to select dedicated spares, follow these steps:

a At the prompt, type y.

b At the next prompt, type 1 or 2.

c Select one or two spares, using the same method you used 
to select disks for the array.

11 When the Initialize Mode menu appears, select Initialize 
Array to Zero. This operation begins immediately. A graph on 
the screen shows the progress of this operation.

Caution: If the drives contain data, all the data is lost 
when you initialize the array.

Select Low-Level Format only if the drives were previously 
formatted on another system or if you think they may have 
surface defects. Low-level formatting takes a long time for 
large-capacity disk drives. (See Initializing an Array on page 2-9 
for more information.)

12 When the menu of block sizes appears, select a block size. (This 
menu does not appear if the array is a mirrored array with only 
two drives.)

The default block size (64 KBytes) gives the best overall 
performance for most applications. The allowable block sizes 
are 8, 16, 32, 64, and 128 KBytes.

13 When you see the message Initialization of [array name] is com-
plete, press any key to return to the Disk Array Operations 
menu.

14 To create additional arrays (if disks are available), return to 
Step 5.

When all arrays are created, exit from ArrayConfigCA2, 
remove the ArrayConfigCA2 diskette, and reboot your desktop 
system. After you reboot, you can reinstall Windows NT on the 
array, if necessary.
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Other Custom Setup Options

Making the Array Bootable
Follow these steps if you want your desktop system to boot from the 
newly created array or if you want to change the boot order of exist-
ing arrays:

1 Select Display Boot Order from the Main Menu. The Boot 
Order for Singles and Arrays window appears.

2 If the newly created array is listed as Unit 0 at the top of the list, 
no changes are necessary; if it has some other unit number, 
highlight the array name and press Enter to select it.

3 Use the arrow keys to move the selected array to the top of the 
list. Then press Enter to deselect it.

4 When you are finished, press Esc to return to the Main Menu.

Note: You cannot use this procedure to change the boot 
order of a stand-alone SCSI disk drive. If you want to do 
this, create a one-disk RAID 0 array from the disk.

For more important information on creating a bootable array, see the 
Installation and Hardware Guide for your adapter.

Displaying Array Information
Follow these steps to display information about existing arrays 
defined in your desktop system:

1 Select Disk Array Operations from the Custom Setup Main 
Menu.

2 Select Display Arrays from the Disk Array Operations menu.

3 When the list of arrays appears, highlight the array for which 
you want information and press Enter.

4 View the information that appears on the screen. This includes 
array type and status, array size, and information about each 
disk in the array.

5 Press any key to return to the Disk Array Operations menu.
2-7
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Deleting an Array

Caution: All data is lost when you delete an array! Before 
you delete an array, back up any data you want to keep.

Follow these steps to delete an array:

1 Select Disk Array Operations from the Main Menu.

2 Select Delete Array from the Disk Array Operations menu.

3 When the list of arrays appears, select the array you want to 
delete.

Caution: A warning appears if you select an array that 
has partitions. Do not delete an array with partitions if 
it contains data you want to keep, because any exist-
ing data will be erased. Be especially careful not to 
select your boot array!

4 View information about the array and make sure you really 
want to delete it. Press any key to continue.

5 Type y to delete the array (or n to cancel the operation).

6 When the message [Array name] deleted appears, press any 
key to continue.

The drives that were formerly part of the array can now be used as 
stand-alone drives or as members of another array. Deleting an array 
may change the boot order and the drive assignment of other arrays 
and disks.
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Initializing an Array
When you create a new array in Custom Setup, you are automati-
cally prompted to initialize (format) it. You can also select the 
Format/Initialize Array option as a separate Custom Setup com-
mand. This could be necessary to reinitialize an array that has 
become corrupted.

Here is some additional information on the two initialization 
methods:

■ Initialize Array to Zero: (Recommended method) Fills the 
array with zeroes. This option is faster than a low-level format, 
but it does not verify the integrity of the disks.

■ Low-level Format: Performs a low-level SCSI format. This 
writes a consistent pattern to the disks, checks the disks for 
defects, and fills the array with zeroes. Low-level formatting 
can take a long time for large-capacity disk drives. You cannot 
abort a low-level format once it has started.

Caution: Formatting or initializing an array erases all data 
on the array and cannot be aborted once it has started. If the 
array contains data you want to keep, be sure to back it up 
first!

Follow these steps to initialize an array:

1 Select Disk Array Operations from the Main Menu.

2 Select Format/Initialize Array from the Disk Array Operations 
menu.

3 When the list of arrays appears, select the array you want to 
initialize.

4 Type y to confirm that you want to initialize the array.

Caution: A warning appears if you select an array that 
has partitions. Do not initialize an array with partitions 
if it contains data you want to keep, because any exist-
ing data will be erased. Be especially careful not to ini-
tialize your boot array!
2-9
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5 When the Select Format Mode menu appears, select Initialize 
Array to Zero (recommended) or Low-Level Format.

6 When the list of block sizes appears, select a block size. The 
allowable block sizes are 8, 16, 32, 64 (the default), or 
128 KBytes. (This menu does not appear if the array is a mir-
rored array with only two drives.) The default block size gives 
the best overall performance for most applications. Formatting 
begins immediately.

7 When you see the message Initialization of [array name] is com-
plete, press any key to return to the Disk Array Operations 
menu.

Creating and Deleting Spares
Dedicated spare disks (spares) are an important data protection and 
real-time recovery feature of RAID 1 arrays. (RAID 0 arrays do not 
support spares.) Up to two dedicated spares can be defined for each 
RAID 1 array. If a disk in an array fails while the computer is run-
ning, a spare is activated immediately to take its place. The array 
software automatically reconstructs the necessary data on the new 
disk, and array operation continues uninterrupted.

Adding a Dedicated Spare
When you create an array you have the option of adding one or two 
dedicated spares to it. You can also add dedicated spares to an exist-
ing array at a later time.

You cannot add dedicated spares to an array if

■ The array already has two dedicated spares

■ The remaining single disks are not at least as large as the small-
est disk in the selected array

Follow these steps to add one or two dedicated spares to an already-
existing RAID 1 array:

1 Select Disk Array Operations from the Main Menu.

2 Select Add/Delete Spare Drive from the Disk Array Opera-
tions menu.

3 Select the array to which you want to add the dedicated spare.

4 Select Add Spare Drive from the Add/Delete Spare menu.
2-10
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5 Select a SCSI channel on the left, if necessary, and then press → 
to move to the list of disks on the right. Disks are grayed out if 
they are already used in an array or if they are smaller than the 
members of the array. Highlight an available disk and press 
Enter. Then select another disk for the second spare, if 
necessary. The new dedicated spare is added immediately.

Caution: A warning appears if you select a disk that 
has partitions. Do not select disks with partitions if 
they contain data you want to keep, because any exist-
ing data will be erased. Be especially careful not to 
select your boot disk as a spare!

6 Press any key to continue.

Deleting a Dedicated Spare
Follow these steps to delete a dedicated spare:

1 Select Disk Array Operations from the Main Menu.

2 Select Add/Delete Spare Drive from the Disk Array Opera-
tions menu.

3 When the list of spare drives appears, select the one you want 
to delete and press Enter.

4 Select Delete Spare Drive from the Add/Delete Spare Drive 
menu. The dedicated spare is deleted immediately.

5 Press any key to continue. The disk that was formerly a dedi-
cated spare can now be used as a spare for another array or as a 
member of a new array.

❒
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Configuring Arrays and 
Spares
This chapter explains how to use Adaptec CI/O Management Soft-
ware to add and delete arrays and spares on your desktop system. 
The following topics are explained in this chapter:

■ Creating an Array on page 3-2

■ Making an Array the Boot Device on page 3-8

■ Deleting an Array on page 3-9

■ Initializing an Array on page 3-11

■ Creating Dedicated Spares or a Spare Pool on page 3-12

■ Deleting a Spare on page 3-15
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Starting the Program
Follow these steps to start the Adaptec CI/O Management Software 
and prepare to configure arrays and spares.

1 Start Windows NT.

2 Double-click the  icon in the Adaptec CI/O Manage-
ment Software group to start the program.

3 If the Storage Configuration window does not open automati-

cally, open it by clicking the  icon on the toolbar.

Creating an Array
Follow these steps to create arrays with Adaptec CI/O Management 
Software.

1 Start Adaptec CI/O Management Software and open the Stor-
age Configuration window, as described in Starting the Program 
on page 3-2. This window looks similar to the one shown in 
Figure 3-1.

Figure 3-1. Storage Configuration Window
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The icons on the left side of the Storage Configuration window 
represent the desktop system’s physical resources—the 
Array1000CA Family device, channels, and SCSI devices 
installed in your desktop system. The icons on the right side 
represent the desktop system’s Array resources—the arrays and 
spares you define. You click the buttons in the middle of the 
window to perform operations on selected device icons.

2 Before you start defining the new array, decide what RAID 
level you want to use, how many disks you want it to have, 
and whether you want to define dedicated spares for the 
array). The following table lists your array options. See Select-
ing a RAID Level for an Array on page 9-7 for information on the 
advantages and disadvantages of each RAID level.

3 Select disks for the new array by clicking disk icons that 
have the word Single beneath them, as shown in Figure 3-2.

PERFORMANCE TIP:
If your main reason for creating an array is speed-
ing up your desktop system’s data I/O perfor-
mance, you should create a RAID 0 array with at 
least two disks. RAID 0 arrays do not use spare 
disks, so you can ignore any instructions about ded-
icated spares or spare pools.

RAID Level
Minimum # of 
Disks Allowed

Maximum # of 
Disks Allowed

Dedicated 
Spares Allowed

RAID 0 (Striped) 11

1 The purpose of one-disk RAID 0 arrays is to give you more control over the virtual device order 
of disks connected to the SCSI channel controlled by the ARO-1130CA2.

16 None

RAID 1 (Mirrored) 2 2 1 or 2
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Do not include disks that you want to use as spares. Click a sec-
ond time on an icon to deselect it, or click the Clear Selection 
button if you want to deselect all disk icons.

Do not select a disk that has a partition. If the partition is rec-
ognized by the operating system, you cannot use the disk in the 
array.

You are prevented from using disks with recognized partitions 
for the array so you will not accidentally erase the boot disk. To 

find out if a disk has a partition, double-click the icon 
and click the Check Partitions button in the SCSI Information 
dialog box. A small popup box indicates whether the selected 
disk has a partition and whether the partition is visible to the 
operating system. If you really want to use a disk with a recog-
nized partition in the array, exit from Adaptec CI/O Manage-
ment Software, back up any data you want to keep, and delete 
the partition from the disk.

Caution: All data on a disk is deleted when it becomes an 
array member! Back up any data you want to keep 
before selecting a disk as an array member.

Figure 3-2. Selecting Array Members
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4 Click the Create Array... button. The Create Array dialog box 
appears, as shown in Figure 3-3.

The number of disks in the array and the array capacity are 
listed on the right of the dialog box.

5 Type a name for the new array. The name can be up to 15 char-
acters, including spaces and any other printable characters. It 
is used to display the array and to identify the source of event 
notifications.

6 Select a RAID level for the array by clicking one of the buttons 
on the left. The bar graphs on the right show you the relative 
levels of data protection, read performance, write perfor-
mance, and capacity utilization for each RAID level.

RAID levels are grayed out if they are not consistent with the 
number of disks you have selected. (See the table on page 3-3.)

7 (Optional) If you created a RAID 1 array, select one or two ded-
icated spares for it from disks on the scrollable list. (Use Ctrl-
Click to select multiple disks.) The disks on the list are the sin-
gle disks you did not select as array members. Select spares 
that are at least as large as the smallest array member. Other-
wise the usable capacity of each array member will be reduced 

Figure 3-3. Create Array Dialog Box
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to the capacity of the spare. (See Creating Dedicated Spares or a 
Spare Pool on page 3-12 to learn how to create a spare pool that 
can be used by any array.)

8 (Optional) Click the Advanced... button to examine or change 
the Advanced Array options. The Advanced Array Options 
dialog box appears. See Setting Advanced Array Options on 
page 3-7 for more information.

9 The Optimize Performance for list box displays the default appli-
cation for performance optimization. Select from the list to set 
cache parameters for one of the options.

10 Click OK and then click Yes to confirm that you want to create 
the array. You will see error messages if your array selections 
are inconsistent. If this happens, change your selections and 
click OK again. You will see a warning if you selected a dedi-
cated spare that is smaller than the array members.

The array is initialized at this point, unless you deselected 
auto-initialize in Advanced Array Options. (If you deselected 
auto-initialize, skip to step 12.) If you want to abort the initial-
ization process (not recommended), open the Array Activity 

Monitor window, select the icon for that array, and 
click Abort.

11 Wait until the new array is initialized. An icon like this 

for the new array appears in the right-hand section of 
the Storage Configuration window. An event notification is 
generated when the initialization process finishes.

Note: Event notifications may appear as popups or just 
as entries in the Event Log, depending on the Event 
Notification options you selected in the Client Settings 
dialog box.

12 Exit from Adaptec CI/O Management Software. Then reboot 
the desktop system. (You cannot use the new array until you 
reboot.) You must then partition the new array with the 
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Windows NT Disk Administrator, just as you would partition 
a new stand-alone disk drive.

Setting Advanced Array Options
The Advanced Array Options dialog box is shown in Figure 3-4. We 
recommend that you do not change these options from their default 
settings unless you fully understand what the options mean and 
you have a specific reason for changing them.

Here is a brief description of the advanced options:

■ Stripe Size is the size that will be used to stripe data across the 
disks in the array. The optimal stripe size depends on the type 
of data being stored on the array and the operating system. 
The default stripe size of 64 KBytes works best for most appli-
cations.

■ Deselect auto-initialize if you want to create the array now but 
initialize it at a later time. You might want to do this if you plan 
to define several arrays and initialize them all at the same time.

Caution: RAID 1 arrays must be initialized before you 
can write data to them. We recommend that you zero-
initialize RAID 0 arrays as well.

■ Click the Restore Defaults button if you want to restore the 
Advanced Array Options settings to the way they were when 
you opened the dialog box.

Figure 3-4. Advanced Array Options Dialog Box
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■ Click the Optimize Performance button if you want to set 
Read/Write caching options for the array. For more informa-
tion on this option, see Using Read and Write Caching on 
page 7-1.

Making an Array the Boot Device
Use this command if you want the desktop system to boot from an 
array instead of from a stand-alone disk. (If you want to use a stand-
alone SCSI disk as your boot device, we recommend that you assign 
SCSI ID 0 to this device.)

You make an array bootable by assigning it virtual device order #0. 
The virtual device order is the sequence in which the operating system 
detects the arrays, single disks, and other installed devices when the 
desktop system boots.

Caution: When you make an array the boot device, the drive 
letters assigned to other drives and arrays may change. This 
can cause data access problems. If you create a bootable 
array with ArrayConfigCA2, you will have more control of 
the virtual device order of the SCSI disk drives on the desk-
top system. See Making the Array Bootable on page 2-7 for 
more information.

Follow these steps to create a bootable array:

1 Start Adaptec CI/O Management Software and open the Stor-
age Configuration window, as described in Starting the Program 
on page 3-2.

2 Click the icon in the right-hand part of the window 
for the array that you want to make bootable.

3 Click the Operations button.

4 Click the button.

5 When the message appears, click OK to confirm that you want 
to make this array the boot device.
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6 Exit from Adaptec CI/O Management Software. If the selected 
array does not already have a bootable partition on it, reboot 
the desktop system with a floppy disk or a CD-ROM drive.

7 Install the operating system on the array. See the Installation 
and Hardware Guide for more information.

The next time you boot the desktop system, it will use this array as 
the boot device.

Deleting an Array

Caution: Back up the data on an array before you delete it. 
All data on the array disks is lost when you delete the array.

If you delete an array, all the disks that were part of the array 
become single, stand-alone disks. You can then use the disks as spares 
or as members of a new array. 

Follow these steps to delete an array:

1 Start Adaptec CI/O Management Software and open the Stor-
age Configuration window, as described in Starting the Program 
on page 3-2.

2 Click the icon in the right-hand area of the window 
for the array you want to delete.

3 Click the Operations button.

4 When the Array Operations dialog box appears, click the 

 button to delete the array.

A warning appears if the selected array has a partition. If the 
partition is recognized by the operating system, you cannot 
delete the array. If the partition is not recognized by the operat-
ing system, you can delete the array.

You are prevented from deleting an array with a recognized 
partition so you will not accidentally delete the boot array. To 
find out if an array has a partition, double-click the 
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icon and click the Check Partitions button in the 
Array Information dialog box. A small popup box indicates 
whether the selected array has a partition and whether the par-
tition is visible to the operating system. If you really want to 
delete an array with a recognized partition, exit from Adaptec 
CI/O Management Software, back up any data you want to 
keep, and delete the partition from the disk. Then start 
Adaptec CI/O Management Software again and delete the 
array.

5 When the confirmation message appears, click OK to confirm 
that you want to delete the array.

Note: After you delete an array you can immediately use the 
disks that formerly belonged to the array to create spares or 
a new array without rebooting the desktop system. How-
ever, you must reboot before you can use the disks as single 
disks that are not members of an array. Deleting an array 
may change the boot order and the drive assignment.
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Initializing an Array
When you create a new array it is initialized immediately by default 
unless you deselect the auto-initialize option, as described on 
page 3-7. If you deselect auto-initialize, you can initialize the array 
later by following the instructions in this section. You can also reini-
tialize an existing array, if necessary.

Caution: All arrays except RAID 0 arrays must be initialized 
or formatted before you can write data to them. We recom-
mend that you zero-initialize RAID 0 arrays as well. All pre-
existing data on the disks is overwritten when you initialize 
an array.

If you want to low-level format the array instead of initializing it 
with zeros, use the ArrayConfigCA2 program. Low-level formatting 
checks the surface of the disks for defects.

Follow these steps to initialize an array:

1 Start Adaptec CI/O Management Software and open the Stor-
age Configuration window, as described in Starting the Program 
on page 3-2.

2 Click the icon of the array you want to initialize. The 
Operations button becomes active.

3 Click the Operations button.

4 When the Array Operations window appears, click the 

button.

A warning appears if the selected array has a partition. If the 
partition is recognized by the operating system, you cannot ini-
tialize the array. You are prevented from initializing an array 
with a partition so you will not accidentally erase the boot 
array. To find out if an array has a partition, double-click the 

icon, and click the Check Partitions button in the 
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Array Information dialog box. A small popup box indicates 
whether the selected array has a partition. If you really want to 
initialize an array with a partition, exit from Adaptec CI/O 
Management Software, back up any data you want to keep, 
and delete the partition from the disk. Then start Adaptec 
CI/O Management Software again and initialize the array.

5 When the confirmation message appears, click Initialize to 
confirm that you want to initialize the array.

To abort the initialization process (not recommended), open 

the Array Activity Monitor window, select the icon for 
that array, and click Abort.

It may take a long time to initialize an array. If you wish, you can 
watch the progress of the initialization process in the Array Activity 
Monitor window.

Creating Dedicated Spares or a Spare Pool
Each RAID 1 array can have one or two dedicated spares, which auto-
matically replace failed array members only for that array. You can 
create dedicated spares when you create the array, or you can add 
them to the array at a later time. Each ARO-1130CA2 can have a 
spare pool of up to eight disks which automatically replace failed 
members of any RAID 1 array whose disks are controlled by the 
card.

Note: When you install Adaptec CI/O Management Soft-
ware it is automatically configured to test all spares once a 
day to assure they are always available, if needed, to replace 
failed disks in arrays. We recommend that you leave this 
default setting so that all spares are tested regularly.

Follow these steps to add a dedicated spare or a pool spare:

1 Start Adaptec CI/O Management Software and open the Stor-
age Configuration window, as described in Starting the Program 
on page 3-2.
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2 Select the disk you want to configure as a spare by clicking on 
its icon in the left-hand part of the window. (Choose a disk that 
has the word Single beneath it.)

3 Click Create Spare... The Create Spare dialog box appears, as 
shown in Figure 3-5. A list of already-defined spares appears 
on the right. Names of existing arrays appear on the left only if 
the disk you selected is large enough to protect that array as a 
spare.

Note: In the Storage Configuration window, pool 
spares are labeled p-spare and dedicated spares are 
labeled d-spare in both the left and right parts of the 
window.

4 If you want to dedicate the spare to a specific array, select Ded-
icated To and click the array name in the scrollable list. If you 
want to add the spare to the pool of spares available to all 
arrays on the controller, do not select the Dedicated To box.

5 Click OK to create the spare. A warning message appears if 
you select a disk that has a partition. If the partition is recog-
nized by the operating system, you cannot use the disk as a 
spare. If the partition is not recognized by the operating system 

Figure 3-5. Create Spare Dialog Box
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(for example, if the disk was previously partitioned under 
another operating system), you can use the disk as a spare.

You are prevented from using disks with recognized partitions 
so you will not accidentally erase the boot disk. To find out if a 

disk has a partition, double-click the icon and click the 
Check Partitions button in the SCSI Information dialog box. A 
small popup box indicates whether the selected disk has a par-
tition and whether the partition is visible to the operating sys-
tem. If you really want to use a disk with a recognized 
partition as a spare, exit from Adaptec CI/O Management 
Software, back up any data you want to keep, and delete the 
partition from the disk.

Newly-created spares are immediately available for use, with-
out rebooting the desktop system. If an array is in Critical sta-
tus, it will be reconstructed as soon as you create the spare 
(unless the spare is dedicated to another array).

Note: You can add a disk of any size to the spare pool, even 
if the disk is too small to protect the existing arrays. For 
example, if you have created an array with 8-GByte disks, 
you can add a 4-GByte disk to the spare pool, even though 
this disk is too small to replace any failed array member.

To see which arrays are protected by an existing spare, select the 
spare in the Existing Spares list; the arrays covered by this spare are 
highlighted in the Existing Arrays list. You can double-click an array 
or a spare to view detailed information about it.

To see which spares protect an existing array, select the array in the 
Existing Array list. The spares that protect the array are highlighted 
in the Existing Spares list.
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Deleting a Spare
Follow these steps to delete a spare disk:

1 Start Adaptec CI/O Management Software and open the Stor-
age Configuration window, as described in Starting the Program 
on page 3-2.

1 Click the icon in the Array part of the window for the spare 
you want to delete. The icons for dedicated spares are labeled 
“d-spare” and the icons for pool spares are labeled “p-spare.”

2 Click Operations

3 When the Spare Operations dialog box appears, click the 
Delete button.

4 When the confirmation message appears, click OK to confirm 
that you want to delete the spare.

After you delete an existing spare, and before you reboot the desk-
top system, you can use a former spare to create a new array or 
spare. However, this disk does not become visible to the operating 
system as a single disk until after you reboot.

❒
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4▼  ▼  ▼  ▼
Viewing Array, Device, and 
System Information
Adaptec CI/O Management Software allows you to view informa-
tion about arrays, spares, SCSI channels, and SCSI devices installed 
in your desktop system. You view this information in the Storage 
Configuration window. Follow these steps to open the Storage Con-
figuration window:

1 Select Configuration from the View menu, or click the  
icon on the toolbar.

2 When the Storage Configuration window appears, double-
click the icon that represents the device for which you want to 
view information. The icons for the more commonly used 
devices are as follows:

– Array

– Spare

– ARO-1130CA2 or AAA-131CA2 card

– Channel
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– Disk Device

The array and spare icons appear on the right side of the Stor-
age Configuration window. The icons representing the RAID 
card, SCSI channel, and SCSI devices appear on the left side of 
the window.

The following sections explain the information that appears when 
you click an icon for a virtual or physical device.

Rescanning the Computer
Whenever you boot your desktop system, the operating system 
software scans it for installed devices such as arrays and SCSI 
devices. Adaptec CI/O Management Software displays icons for 
these devices in the Storage Configuration window.

You may need to issue a Rescan command while Adaptec CI/O 
Management Software is running so it can “see” the new hardware 
configuration. You need to do a rescan if

■ You connect a new SCSI device to the Adaptec array card 
without using the Pause I/O command

■ You disconnect a SCSI device from the Adaptec array card 
without using the Pause I/O command

A rescan is done automatically whenever you pause I/O and 
resume I/O to an array or a device. You do not need to issue a 
Rescan command to detect a failed array member. Adaptec CI/O 
Management Software will detect the failed member automatically 
if I/O is occurring on the array.

Follow these steps to rescan the computer:

1 Click the  button on the toolbar. The Storage 
Configuration window appears.

2 Click the Rescan button.

3 When the message appears, click Yes to confirm that you want 
to rescan the system. When the rescan is complete, any 
hardware changes are reflected in the icons in the Storage 
Configuration window.
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4 Click OK when the message appears indicating that the rescan 
was completed successfully.

Note: If you remove a disk that is an array member, replace 
it with another disk, and issue a Rescan command, Adaptec 
CI/O Management Software will detect that the new disk is 
no longer an array member.

Viewing Array Information

When you double-click an array icon  in the Storage Config-
uration window, the Array Information dialog box appears, as 
shown in Figure 4-1.

The following information appears in the Array Information dialog 
box:

■ Status: current status of the array, such as On-line, Off-line, 
Fault-tolerant, Critical, etc.

■ Model: ARO-1130CA2 or AAA-131CA2

■ Array type: RAID level of the array. The supported levels are 
RAID 0 and RAID 1.

Figure 4-1. Array Information Dialog Box
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■ Capacity: total usable disk space available in the array, in 
MBytes.

■ Member size: size of the array members.

■ Array members: number of disks in the array.

■ Dedicated spares: number of spare disks dedicated to this 
array, if any.

■ Available pool spares: number of pool spares available to pro-
tect this array, if any.

Click the Check Partitions button to determine if the array has a 
partition. A small dialog box indicates whether the selected array 
has a partition and whether the partition is visible to the operating 
system.

Click the Caching button to view information about the array’s 
Read and Write caching options. (The caches exist in memory on the 
adapter board.) For more information, see Using Read and Write 
Caching on page 7-1.

When you click the Detail button, you can view the following addi-
tional information about the array:

■ Stripe size: data striping size used on this array.

■ Virtual device order: the sequence in which the operating sys-
tem detects this array when it boots. If the array’s virtual 
device order is 0, then this array is the first device the operat-
ing system detects at boot time.

■ Creation date: date on which the array was created.

■ Date of last verify: date on which the array was last verified. 
See Verifying Array Integrity on page 5-5 for information on 
how to verify an array.

■ Date of last reconstruct: date on which the array was last 
reconstructed. See Reconstructing an Array on page 5-2 for 
information on how to reconstruct an array.

Click Close to close the Array Detail and Array Information dialog 
boxes.
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Viewing Spare Information

When you double-click a spare icon in the right side of the Stor-
age Configuration window the Spare Information dialog box 
appears, as shown in Figure 4-2.

When you double-click a spare icon in the left side of the window 
you will see the SCSI Information dialog box, the same as for a sin-
gle SCSI disk.

The Spare Information dialog box shows which array the spare is 
dedicated to, whether it is a member of a spare pool, its capacity, and 
its current status. An Available status means the spare is fully func-
tional and is available to replace a failed array disk.

Note: The spare icons in the Storage Configuration window 
are labeled p-spare for pool spares and d-spare for dedi-
cated spares.

Click Close to close the Spare Information dialog box or SCSI Infor-
mation dialog box.

Figure 4-2. Spare Information Dialog Box
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Viewing RAID Card Information

When you double-click an RAID card icon , the Controller 
Information dialog box appears, as shown in Figure 4-3.

The information in the Controller Information dialog box is self-
explanatory. The PCI bus number field indicates which PCI bus the 
adapter is installed in.

Click the Capabilities button to view a list of the features that the 
adapter supports. The list is informational only; you cannot enable 
or disable the capabilities on the list. Here are some controller capa-
bilities that may appear on the list:

■ Automatic Verify: indicates that the product automatically 
verifies SCSI parity.

■ Auto Fix: indicates that the product automatically corrects data 
miscompares.

■ Supported RAID Levels: lists the RAID levels the product 
supports.

■ Maximum Number of Spares: lists the maximum number of 
pool spares that the product supports.

■ Maximum Number of Physical Arrays: lists the maximum 
number of arrays the product supports.

■ Maximum Number of Drives for a Single Array: lists the 
maximum number of disks the product supports for a single 
array.

Figure 4-3. Controller Information Dialog Box
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■ Maximum/Minimum Stripe Size: lists the range of data and 
parity stripe sizes that the product supports.

■ Spare Pool: indicates that the product supports using spares 
from a spare pool.

Click Close to close the Capabilities dialog box and the Controller 
Information dialog box.

Viewing Channel Information

When you double-click a channel icon , the Channel Informa-
tion dialog box appears, as shown in Figure 4-4.

The following information appears in the Channel Information dia-
log box:

■ Status: current operational status of the channel (for example, 
Active, Inactive).

■ Channel type: type of this channel—for example, SCSI.

■ Maximum Devices: maximum number of SCSI devices that 
the channel supports.

■ Current Devices: number of SCSI devices currently connected 
to the channel.

Click Close to close the Channel Information dialog box.

Figure 4-4. Channel Information Dialog Box
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Viewing SCSI Device Information

When you double-click a SCSI device icon, such as a disk , 
the SCSI Information dialog box appears, as shown in Figure 4-5.

The information in this dialog box is self-explanatory. When you are 
creating an array you can view this dialog box to determine if a disk 
you want to use for the array has partitions on it. Simply click the 
Check Partitions button. A small popup box indicates whether the 
selected disk has a partition and whether the partition is visible to 
the operating system.

Note: You cannot use a disk in an array if it has a partition 
that is visible to the operating system. (This is a safety fea-
ture that prevents you, for example, from accidentally eras-
ing your boot disk.) If you really do want to use a disk with a 
recognized partition in the array, exit from Adaptec CI/O 
Management Software, back up any data you want to keep, 
delete the partition, and then run Adaptec CI/O Manage-
ment Software again.

Click Close to close the SCSI Information dialog box.

Figure 4-5. SCSI Information Dialog Box
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Viewing System Event Information
Adaptec CI/O Management Software maintains a log of informa-
tion about array-related events that occur on your desktop system. 
The information is saved in a log file and can be viewed on the 
screen. System events include creating or deleting an array, verifying 
the integrity of an array, failure of a disk in an array, etc.

Follow these steps to view the log of system events:

1 Click the  button on the toolbar. The Historic Event Log 
appears, as shown in Figure 4-6.

2 View the system event information. New entries are added to 
the top of the list as they occur. A color-coded circle at the 
beginning of each message indicates its severity. (See the next 
section, Interpreting and Responding to System Event Messages, 
for more information.)

3 To view detailed information about a log entry, double-click 
the entry, or highlight the entry and click the Detail button. 
The Log Detail dialog box appears. Click OK when you are fin-
ished viewing this dialog box.

Figure 4-6. Historic Event Log Window
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4 Click Filter to change the message filter options. These changes 
apply only while the window is open and will revert to the 
defaults if you close the Historic Event Log and open it again. 
We recommend that you leave all boxes checked so all system 
messages will be displayed. Follow the instructions in Setting 
Preferences on page 4-12 if you want to permanently change the 
filter settings.

If you choose to filter out some kinds of messages, the Items 
displayed number above the log entries lists the number of mes-
sages that are actually displayed. The Items total field always 
indicates the total number of messages of all types.

5 Click Clear All to delete all existing log entries. Click Save As 
to save the log to a file.

Note: When you open the Historic Event Log, only the 
most recent log entries are initially retrieved from the 
log file. If you scroll down beyond these entries, 
another groups of entries is retrieved. This avoids the 
delay that might occur if an entire large log file were 
retrieved at one time. To keep the log file from getting 
too large, specify a maximum size for it in the initial-
ization file. (See Appendix A, Configuration Settings.)

6 Click OK to All to acknowledge all outstanding events for the 
system.

7 Close the window when you are finished viewing log entries, 
or minimize it as an icon on the screen.
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Interpreting and Responding to System Event Messages
There are three severity levels for system events:

Note: When an application is minimized, any outstanding 
event will include a blinking icon.

■ Critical event messages (red dot) indicate an array prob-
lem that requires immediate action. An example is an array 
going off-line because two array members have failed. See 
Responding to an Off-line Array on page 9-4 for more 
information.

■ Warning event messages (yellow dot) indicate an array or 
system problem that may require attention.

■ Informational event messages (green dot) inform you 
about some normal operation, such as creating a new array, 
adding a spare, or verifying an array.
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Setting Preferences
You use the Preferences dialog box to specify how you want to be 
notified of system events and what kinds of events you want to view 
in the Historic Event Log. The preferences that you set here remain 
in effect until you change them again.

Follow these steps to change or view event preferences:

1 Click the  button. The Preferences dialog box appears, as 
shown in Figure 4-7.

2 Click the Notification button to change the way in which you 
are alerted of event notifications. The Event Notifications 

Figure 4-7. Preferences Dialog Box
4-12



Viewing Array, Device, and System Information
Options dialog box appears, as shown in Figure 4-8. Select one 
or more options, then click OK to save the settings.

Note: Adaptec CI/O Management Software always 
notifies you of Critical events with a pop-up message, 
a beep, and a flashing title bar.

3 Click the Filter button to view the Log Filter dialog box, as 
shown in Figure 4-9. Select or deselect the check boxes to 
change the filtering of messages in the Historic Event Log, then 
click OK to save these settings.

We recommend that you select all the boxes so you are fully 
informed of all system events.

Figure 4-8. Event Notification Options Dialog Box

Figure 4-9. Log Filter Dialog Box
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4 Click OK to change the option information or to close the Pref-
erences dialog box. These settings are the new default settings 
for the Historic Event Log window.

❒
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Performing Operations on 
Arrays and Other System 
Devices
You can use Adaptec CI/O Management Software to perform a 
number of operations on arrays, spares, RAID cards, channels, and 
stand-alone disk drives. These operations include reconstructing an 
array, testing spares, changing Read/Write cache settings, and 
graphing the performance of your desktop system. Some of the 
operations are performed immediately; others can be scheduled for 
a later time, or can be scheduled to occur at stated intervals.

To perform operations on arrays and other system devices, you first 
open the Storage Configuration window. To do this:

1 Select Configuration from the View menu, or click the 

icon on the toolbar.

2 When the Storage Configuration window appears, single-click 

an icon that represents an array , spare , RAID 

card , SCSI channel , or SCSI disk .

When you do this, the Operations button becomes active.
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3 Click the Operations button. A dialog box appears with icons 
for the operations that you can perform on the selected device.

4 Click the button for the operation you want to perform. See the 
appropriate section of this chapter for a description of these 
operations.

Performing Array Operations
Here is a list of the array operations. (Note that some of these opera-
tions are described in other chapters.)

■ Reconstructing an Array on page 5-2

■ Verifying Array Integrity on page 5-5

■ Pausing I/O on an Array on page 5-7

■ Blinking Array Drive Lights on page 5-9

■ Reactivating an Off-line Array on page 5-9

■ Changing an Array Name on page 5-10

■ Forcing a Spare on page 5-11

■ Making an Array the Boot Device on page 3-8

■ Deleting an Array on page 3-9

■ Initializing an Array on page 3-11

■ Optimizing Array Performance (See Using Read and Write Caching 
on page 7-1)

■ Graphing Array Performance (See Graphing System Performance 
on page 7-8)

Reconstructing an Array
If a spare disk is available when a disk in a RAID 1 array fails, the 
data on the disk is automatically reconstructed on the spare, and 
you do not need to use the Reconstruct operation. However, if a disk 
in an array fails and no spare is available to replace it, you receive an 
event notification that the array is Critical. You may need to recon-
struct the array with this command after the drive is replaced. In 
either case, data on the array is not lost.
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You can reconstruct an array immediately after you replace the 
failed disk (recommended), or you can schedule the reconstruct to 
occur at a later time.

Follow these steps to reconstruct a RAID 1 array when a disk fails:

1 Determine which array is in Critical status and which disk in 
the array has failed.

2 Turn OFF the desktop system, disconnect the power cord, and 
open the computer case.

WARNING: Be sure that you have turned OFF the desk-
top system and disconnected the power cord before 
you continue. See the system documentation for 
instructions on opening the computer case.

3 Replace the failed disk with a good disk of at least the same 
storage capacity. Be sure that the SCSI ID of the new disk is dif-
ferent from the SCSI ID of other installed devices. Or, if an 
array disk was accidentally disconnected, reconnect it.

4 Close the computer case, reconnect the power cord, and turn 
ON the desktop system.

5 If you installed a new disk (or disks), make the disk into a 
spare by following the directions in Creating Dedicated Spares or 
a Spare Pool on page 3-12. Be sure the new spare disk is at least 
as large as the smallest array member.

Note: When the spare is created, Adaptec CI/O Man-
agement Software should automatically start a Recon-
struct operation on the array. If for some reason the 
reconstruct does not begin automatically, follow the 
remaining steps to perform it manually.

6 Select Configuration from the View menu. The Storage Con-
figuration window appears.

7 Click on the array icon that looks like this . The Opera-
tions button becomes active.
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8 Click the Operations button. The Array Operations dialog box 
appears, as shown in Figure 5-1.

9 Click the button. The Scheduler dialog box appears.

10 Enter the required information for the Reconstruct operation in 
the Scheduler dialog box. You can select Immediate to recon-
struct the drive immediately or select Once to schedule the 
operation for a later time. (See Setting Scheduling Options on 
page 6-1 for more information.)

11 Select an Execution Priority - high, medium, or low.

12 Click OK.

13 When the message appears, confirm that you want to recon-
struct the array member.

14 Read the event notifications that appear in the Historic Event 
Log (they may also appear as popups on the screen) to deter-
mine when the reconstruct is complete.

Open a Watch box if you want to monitor the progress of the array 
reconstruction. (See Monitoring Activities that are Running on 
page 6-5.)

Figure 5-1. Array Operations Dialog Box
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Verifying Array Integrity
Use this option to verify the integrity of redundant data stored on 
RAID 1 arrays. When you run this operation, Adaptec CI/O Man-
agement Software checks the array for miscompares and corrects 
them automatically. A miscompare occurs when some part of the data 
on a mirrored disk pair in a RAID 1 array does not match.

In Adaptec CI/O Management Software you can schedule the Verify 
operation to run later or schedule it to run at a regularly occurring 
interval. We recommend that you schedule a verification of all 
arrays at least once a week. See Setting Scheduling Options on 
page 6-1 for more information.

Follow these steps to verify the integrity of redundant array data:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on the array icon . The Operations button becomes 
active.

3 Click the Operations button.
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4 When the Array Operations dialog box appears, click the 

 button to verify the data on the array. The Scheduler 
dialog box appears, as shown in Figure 5-2.

5 Leave the autofix box checked so that data mirroring mis-
matches will be corrected automatically.

6 Select Immediate if you want to verify parity immediately, or 
select Scheduled if you want to schedule the operation for a 
future time.

7 If you select Scheduled, enter a start time, start day of the 
week, and other information. (See Setting Scheduling Options on 
page 6-1 for more information.)

8 Select an Execution Priority - high, medium, or low. This 
determines how much system resources are devoted to the 
operation. A high priority means the Verify operation will use 

Figure 5-2. Scheduler Dialog Box
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a lot of system resources, which may slow down other system 
activity.

9 Click OK to start the operation (if you selected Immediate) or 
to enter it on the list of scheduled activities.

You can open a Watch window to monitor the progress of the opera-
tion as it is running. See Monitoring Activities that are Running on 
page 6-5 for more information.

Pausing I/O on an Array
Use this option to temporarily stop I/O transactions on the SCSI bus 
while you replace a disk or reconnect a loose connection in an array 
enclosure that does not support hot swapping1. If you have an array 
enclosure and it supports hot swapping, you probably do not need 
to pause I/O to replace a disk. See the array enclosure 
documentation for more information.

When you pause an array, all other devices on all channels on the 
Adaptec array card are also paused. I/O is automatically resumed 
after a specified pause interval.

Caution: Pause I/O cannot assure the same level of protec-
tion from electrical noise that you have when you replace a 
disk in an enclosure that supports hot swapping. Every time 
you use this feature, you should only perform one action—
either disconnecting a drive or inserting a drive, but not 
both. Do not replace a non-downed drive in a paused array, 
as this may cause data to be corrupted. Instead, down the 
drive first and then replace it.

Follow these steps to pause and resume I/O on an array:

1 Open the Storage Configuration window and select the icon of 

the array you want to pause.

1 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad disk is replaced.
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2 When the Array Operations dialog box appears, click the

button.

3 When the Pause I/O dialog box appears, enter a pause interval 
no greater than 120 seconds, and click OK to pause the array.

Note: The Pause I/O command is disabled if a Verify, 
Reconstruct, or Initialize operation is running.

4 Remove the disk drive you want to replace. Data I/O resumes 
automatically at the end of the pause period.

5 Pause I/O again, entering a pause interval as described above.

6 While I/O is paused, replace the disk drive you removed with 
a new disk drive. Data I/O resumes automatically at the end of 
the pause period.

Caution: Be sure to use two pause I/O periods, as 
described in the steps above. Data may be corrupted if 
you remove a drive and replace it in the same pause 
I/O operation. You must replace the device with the 
same kind of SCSI device. You should not, for exam-
ple, replace a disk drive with a CD-ROM drive while 
I/O is paused.
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Blinking Array Drive Lights
You can issue a command to blink the drive lights of all the disks in 
a selected array. This allows you to see which physical drives 
actually form the array.

Note: Adaptec CI/O Management Software does not sup-
port blinking the drive lights on CD-ROM drives.

Follow these steps to blink the drive lights of the disks in an array:

1 Select Configuration from the View menu. The Storage 
Configuration window appears.

2 Click on an Array icon in the right side of the dialog box. The 
Operations button becomes active.

3 Click the Operations button.

4 When the Array Operations dialog box appears, click the

 button.

5 Look at the array enclosure to see which disks are members of 
the array.

6 Click the Unblink all button in the Storage Configuration 
dialog box to stop the drive lights from blinking.

Reactivating an Off-line Array
An array may go off-line because a cable is disconnected, because a 
disk failed, or because you mistakenly removed the wrong disk 
while trying to replace a failed disk. In these situations, the array 
shuts down temporarily. Depending on the reason why the array 
went off-line, it is possible that you can reactivate it and resume I/O 
without data loss. See Responding to an Off-line Array on page 9-4 for 
more information.

After you correct any hardware problems, follow these steps to reac-
tivate an off-line array:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.
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2 Click on the grayed-out icon of the off-line array. The Opera-
tions button becomes active.

3 Click the Operations button.

4 When the Array Operations dialog box appears, click the 

 button.

5 When the message appears, confirm that you want to reacti-
vate the array. Be sure that any hardware problems are cor-
rected before you do this.

For RAID 0 arrays, run chkdsk to check the file system 
integrity.

Changing an Array Name
When you create an array, you give it a name. This name appears 
beneath the array icon and in many of the windows and dialog 
boxes. It is also used to identify the source of event notifications. You 
can change this name at a later time, if necessary.

Follow these steps to change the name of an existing array:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click the icon of the array whose name you want to 
change. The Operations button becomes active.

3 Click the Operations button.

4 When the Array Operations dialog box appears, click the 

 button. The Change Name dialog box appears.

5 Type the new array name and click OK.

6 When the confirmation message appears, confirm that you 
want to change the array name. This change appears immedi-
ately in the Storage Configuration window.
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Forcing a Spare
Forcing a spare means issuing a command for a spare disk to replace 
a specific disk in an array. You can do this if the array disk is not per-
forming well and is giving some indication that it may fail soon. (If 
an array member actually does fail, a spare replaces it automatically 
without requiring you to force a spare.)

Follow these steps to force a spare:

1 Be sure that one or more spares are available for the array. 
These can either be dedicated spares for the array or spares 
from a spare pool. See Creating Dedicated Spares or a Spare Pool 
on page 3-12 for more information on configuring spares.

2 Select Configuration from the View menu. The Storage Con-
figuration window appears.

3 Click on the icon of the array with the suspect disk. The Opera-
tions button becomes active.

4 Click the Operations button.

5 When the Array Operations dialog box appears, click the 

 button. This button is grayed out if no spares are 
available.

6 Select the disk that you want to replace.

7 Click OK to replace this disk with a spare.

8 When the confirmation message appears, confirm that you 
want to replace the disk with the spare. At this point the spare 
is automatically activated to replace the disk.

If there is a pool of available spares, you cannot control which disk 
from the pool is activated when you force a spare. You can control 
this if there is only one dedicated spare or one pool spare. If both ded-
icated spares and pool spares are available, the dedicated spares are 
used first. An error message appears if the spare is not at least as 
large as the smallest disk in the array. If this happens, add a larger 
spare.
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Performing Spare Operations
Here is a list of the spare operations available in Adaptec CI/O Man-
agement Software. (Note that Deleting a Spare is covered in an ear-
lier chapter):

■ Testing All Spares on page 5-12

■ Blinking the Spare Drive Light on page 5-13

■ Deleting a Spare on page 3-15

Testing All Spares
Reliable spares must be available to immediately (and automati-
cally) replace any array disk that fails. Spares should be tested regu-
larly to assure that they are working properly. We recommend that 
you test all spares daily. You can run this operation immediately by 
issuing a command, or you can use the Scheduler function to set up 
a recurring check of all the spares at a later time.

Note: When you install Adaptec CI/O Management Soft-
ware it automatically sets up a daily Test All Spares opera-
tion. We recommend that you leave this default setting so 
that all spares are tested regularly.

Follow these steps to test all spares:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on the icon of any spare on the right side of the dialog 
box. The Operations button becomes active.

3 Click the Operations button.

4 When the Spare Operations dialog box appears, click the 

 button. The Scheduler dialog box appears, as shown in 
Figure 5-2 on page 5-6.

5 Select Immediate if you want to test all spares immediately, or 
select Scheduled if you want to schedule the operation for a 
later time.
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6 If you select Scheduled, enter a starting time, starting day, and 
other information.

7 Click OK to start the operation (if you selected Immediate) or 
to enter it on the list of scheduled activities.

8 When the confirmation message appears, confirm that you 
want to test the spares.

9 When the test is finished, look at the spare disk icons in the 
Storage Configuration window. The icons of the failed disks 

will look like this .

10 Replace any failed disks immediately with good disks of at 
least the same capacity.

Blinking the Spare Drive Light
You can issue a command to blink the drive light of a spare. This 
allows you to see which physical drive is the actual spare.

Follow these steps to blink the drive light of a spare:

1 Select Configuration from the View menu. The Storage 
Configuration window appears.

2 Click a Spare icon in the right side of the dialog box. The 
Operations button becomes active.

3 Click Operations.

4 When the Spare Operations dialog box appears, click the

 button.

5 Look at the array enclosure to see which disk light is blinking.

6 Click Unblink all in the Storage Configuration window to stop 
the drive light from blinking.
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Performing RAID Card Operations
If you select an RAID card icon, you have two operation options: 
Optimizing Performance and Graphing.

Optimizing RAID Card Performance
Follow these steps to optimize RAID card performance by adjusting 
the Read and Write caching options:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on an RAID card icon in the left side of the dialog box. 
The Operations button becomes active.

3 Click the Operations button.

4 When the Adapter Operations dialog box appears, click the 

 button. A list of arrays controlled by the RAID card 
appears.

5 Select the array whose caching options you want to change 
and click the Caching button. (Each array has its own Read 
and Write cache, so you must change the options separately for 
each device.) The Optimize Performance dialog box appears.

6 Change cache settings as needed. Follow the instructions in 
Using Read and Write Caching on page 7-1.

Graphing RAID Card Performance
Follow these steps to view a graph of the RAID card I/O 
performance:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on an RAID card icon in the left side of the dialog box. 
The Operations button becomes active.

3 Click the Operations button.
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4 When the Adapter Operations dialog box appears, click the 

 button. The CI/O Profiler window appears.

5 Follow the instructions in Graphing System Performance on 
page 7-8. The information you will see on the graph is a total 
for all arrays and disks controlled by the RAID card.

Performing SCSI Channel Operations
If you select a SCSI channel icon, you can view a graph of I/O per-
formance on the channel.

Graphing SCSI Channel Performance
Follow these steps to view a graph of the I/O performance on the 
SCSI channel:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on a SCSI channel icon in the left side of the dialog box. 
The Operations button becomes active.

3 Click the Operations button.

4 When the Channel Operations dialog box appears, click the 

 button. The CI/O Profiler window appears.

5 Follow the instructions in Graphing System Performance on 
page 7-8. The information you will see on the graph is a total 
for all arrays and disks connected to the selected channel.
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Performing Disk Operations
You can perform the following operations with a disk drive that is 
an array member:

■ Blinking the Drive Light on page 5-16

■ Downing a Drive on page 5-16

You can also graph the disk performance of a single disk that is not 
an array member. See Graphing System Performance on page 7-8.

Blinking the Drive Light
You can issue a command to blink the light of a disk whose icon you 
have selected. This allows you to see which physical disk 
corresponds to the Disk icon.

Note: Adaptec CI/O Management Software does not 
support blinking the drive lights on CD-ROM drives.

Follow these steps to blink a drive light:

1 Select Configuration from the View menu. The Storage 
Configuration window appears.

2 Click a Disk icon in the left side of the window. The Operations 
button becomes active.

3 Click Operations.

4 When the Drive Operations window appears, click the  
button.

5 Look at the array enclosure to see which disk light is blinking.

6 Click Unblink all in the Storage Configuration dialog box to 
stop the drive light from blinking.

Downing a Drive
Use this option to stop all data I/O to a member of an array. You 
might need to do this if the disk generates a S.M.A.R.T.1 alert indi-
cating that it is about to fail. When you down a member of a RAID 1 
array, a spare is activated immediately (if available) to replace it, and 
a reconstruct is triggered.
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Note: The Down a Drive command can only be used for 
array members, not for spare disks or single disks.

Follow these steps to down a disk drive:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Select the icon of the disk you want to down.

3 Click the Operations button.

4 When the Drive Operations dialog box appears, click the 

button. If a spare is available, it replaces the downed 
disk immediately and a reconstruct of the array is triggered.

5 Wait until the Reconstruct operation is completed.

1 S.M.A.R.T. stands for Self-Monitoring, Analysis and Reporting Technology. 
Hard disk drives that support this technology continually analyze their per-
formance and generate an alert if they determine that the disk is likely to fail 
soon. Adaptec CI/O Management Software generates an event notification 
if it receives this alert, giving you an opportunity to replace the disk before 
it actually fails.
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Pausing I/O to an Array Disk Drive
Use this option to pause data I/O on a disk drive that is connected 
to an Adaptec array card. You can use this option to replace the disk 
if it is in an array enclosure and the array enclosure does not support 
hot swapping1. See the array enclosure documentation for more 
information. When you pause I/O to a disk drive, all other devices 
connected to the Adaptec array card are paused as well. I/O 
resumes automatically at the end of the pause period.

Caution: Pause I/O cannot assure the same level of protec-
tion from electrical noise that you have when you replace a 
disk in an enclosure that supports hot swapping. Every time 
you use this feature, you should only perform one action—
either disconnecting a drive or inserting a drive, but not 
both. Do not replace a non-downed drive in a paused array, 
as this may cause data to be corrupted. Instead, down the 
drive first and then replace it.

Follow these steps to pause data I/O to a disk drive:

1 Select Configuration from the View menu. The Storage 
Configuration window appears.

2 Select the icon of the disk you want to pause.

3 Click Operations. When the Array Operations dialog box 

appears, click the  button.

4 When the Pause I/O dialog box appears, enter a pause interval 
no greater than 120 seconds, and click OK to pause the array.

Note: The Pause I/O command is disabled if a Verify, 
Reconstruct, or Initialize operation is running.

1 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad drive is replaced.
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5 Remove the disk drive you want to replace. Data I/O resumes 
automatically at the end of the pause period.

6 Pause I/O again, entering a pause interval as described above.

7 While I/O is paused, replace the disk drive you removed with 
a new disk drive. Data I/O resumes automatically at the end of 
the pause period.

Caution: Be sure to use two pause I/O periods, as 
described in the steps above. Data may be corrupted if 
you remove a drive and replace it in the same pause 
I/O operation. You must replace the device with the 
same kind of SCSI device. You should not, for exam-
ple, replace a disk drive with a CD-ROM drive while 
I/O is paused.

❒
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6▼  ▼  ▼  ▼
Scheduling and Monitoring 
Array Operations
Adaptec CI/O Management Software enables you to schedule some 
kinds of operations to run at a later time, or to schedule them to run 
at regularly recurring intervals. You set up these scheduled jobs 
when you give the command to run the activity, as described in Ver-
ifying Array Integrity on page 5-5, Reconstructing an Array on page 
5-2, and Testing All Spares on page 5-12.

Setting Scheduling Options
The Scheduler dialog box allows you to schedule the Reconstruct an 
Array, Verify Integrity of Array, and Test All Spares operations. 
Reconstruct an Array is a one-time event for which you can enter a 
date and time. Verify Integrity of Array and Test All Spares can be 
scheduled as hourly, daily, or monthly recurring events. The Sched-
uler appears automatically when you define a new scheduled 
operation.
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Follow these steps to set scheduling options for a newly added 
operation:

1 Define a new scheduled operation: Reconstruct an Array, Ver-
ify Integrity of Array, or Test All Spares. The Scheduler dialog 
box appears, as shown in Figure 6-1.

2 Select Immediate to perform the action immediately or Sched-
uled to schedule it for later.

3 If you select Scheduled, select Once, Periodically, Daily, or 
Weekly. Enter other information such as day of the week or 
start time/date, as required.

Note: If you are scheduling an array reconstruct, you 
can only select the Once option.

4 Click OK to record the scheduling options. You may be 
prompted to confirm the activity.

Figure 6-1. Scheduler Dialog Box
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Viewing and Managing Scheduled Activities
You can view information about scheduled and currently running 
activities in the Array Activity Monitor window. You can abort 
activities that are running or delete scheduled activities.

Note: When you install Adaptec CI/O Management Soft-
ware it automatically sets up a daily Test All Spares opera-
tion.

Follow these steps to view and manage scheduled activities:

1 Select Activities from the View menu. The Array Activity 
Monitor window appears, as shown in Figure 6-2.

2 Select an activity icon from the left part of the window. Infor-
mation about the activity is shown in the window. Each kind of 
activity has a distinctive icon. The icon labels indicate which 
array or spare the activity applies to.

Figure 6-2. Array Activity Monitor Window
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To view more detailed information about the activity, double-
click the activity icon. The Scheduler dialog box appears, as 
shown in Figure 6-1. Click Cancel to close the dialog box.

3 If you want to change the priority of a Verify or Reconstruct 
operation that is currently running (as indicated by a moving 
icon), select the activity icon on the left of the window and then 
click Change Priority. When the Change Priority dialog box 
appears, select an option and click OK.

Note: The priority change applies only while the activ-
ity is running this time. If it is a regularly scheduled 
activity, the next time it runs it will have the priority 
originally assigned to it. You cannot change the prior-
ity of an Initialize or Test all Spares operation that is 
currently running.

4 If you want to delete an activity that is not currently running, 
select its icon and click the Delete button. After you confirm 
the command, the activity is deleted from the list.

5 If you want to abort a currently-running activity, select its icon 
and click the Abort button. After you confirm the command, 
the activity stops running immediately. If this is a regularly 
recurring activity, such as a nightly test of all spares, it will run 
again in the future at the next scheduled time. Use Abort and 
then Delete if you want the activity to never run again.

6 Click the Watch button to open a small window to monitor the 
selected, currently running activity. See the following section 
for more information.
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Changing the System Time
Do not change the system time while Adaptec CI/O Management 
Software is running. If you do, scheduled activities may not run at 
the specified times. Follow these steps if you need to change the sys-
tem time:

1 Delete all scheduled activities.

2 Stop all Adaptec CI/O Management Software services and 
RPC services.

3 Change the system time.

4 Restart the Adaptec CI/O Management Software services and 
RPC services.

5 Reschedule the scheduled activities.

Monitoring Activities that are Running
You can open one or more Watch windows to monitor currently-
running array activities. You can leave these small windows open 
while you continue doing other work on the desktop system.

When a Verify operation completes, the Watch window shows the 
total number of miscompares. A miscompare occurs when some part 
of the data on a mirrored disk pair in a RAID 1 array does not match. 
If you checked the Auto Correct box in the Verify dialog box, the 
miscompares are automatically fixed.

Follow these steps to monitor activities that are running:

1 Select Activities from the View menu. The Array Activity 
Monitor window appears.

2 Select the icon of a currently-running activity from the scrolla-
ble list at the top of the window.

3 Click the Watch button. A small Watch window for this activ-
ity appears, as shown in Figure 6-3. Each window has a per-
cent complete graph and a Status field (OK, Done, Failed). If a 
Verify operation is running, there is also a field listing the num-
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ber of miscompares found. Click Close to close the Watch win-
dow after the activity has completed.

❒

Figure 6-3. Watch Window
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7▼  ▼  ▼  ▼
Optimizing and Monitoring 
System Performance
Using Read and Write Caching
Your Adaptec RAID card has a built-in, onboard Read/Write cach-
ing feature that allows faster data I/O to arrays controlled by the 
card. The Adaptec CI/O Management Software allows you to define 
Cache values for optimizing the performance of a specific applica-
tion.

■ Read Caching improves I/O performance by anticipating 
which data is likely to be read next and keeping that data in 
cache memory on the RAID card. When the application actu-
ally needs the data, it can read it in much faster from the 
onboard cache than from disk.

■ Write Caching improves I/O performance by temporarily 
storing data that needs to be written to disk in a cache on the 
adapter card and then writing it to disk moments later when 
there is less system activity. (Data can be written much faster to 
the cache than to the disk.) Moreover, the read performance 
improves if the application needs to immediately read the data 
that was just written to the write cache.
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Adaptec CI/O Management Software automatically enables Read 
and Write caching for all arrays controlled by the RAID card. To 
achieve the best I/O performance, we recommend that you leave the 
caching options at their default settings. If you are an advanced user, 
read the information in this chapter to learn how to change the cach-
ing options. This may enable you to achieve additional I/O 
improvements. You can set the caching options individually for each 
array controlled by the adapter card.

Note: The Adaptec Web Site at 
http://www.adaptec.com/RAID has some specific tips for 
optimizing your desktop system’s caching configuration.

Follow these steps to enable or disable Read or Write caching for an 
array controlled by the Adaptec RAID card:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Select an array icon and Click the Operations button.
7-2



Optimizing and Monitoring System Performance
3 When the Array Operations dialog box appears, click the 

button. The Optimize Performance dialog box appears, 
as shown in Figure 7-1.

Note: To get an overview of how much Read/Write 
cache is used and how much is available for all arrays 
controlled by an RAID card, select an RAID card icon. 

Click the Operations button and the button. 
You will see a list of arrays and the cache settings for 
each array. Double-click any array name (or highlight 
it and click the Caching… button) to change its cache 
settings.

4 Read the general information at the bottom of the Optimize 
Performance dialog box. This includes the total cache available 

Figure 7-1. Optimize Performance Dialog Box
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on the array adapter, the amount of cache that is currently 
available, and the amount of cache used internally by the 
adapter (this is read-only and provided by the device driver). 

5 Select or deselect the Caching Enabled check box. This is the 
top-level control for all caching on this array. When you enable 
caching, Adaptec CI/O Management Software assigns default 
values to the Read and Write Cache.

You can click the Restore Defaults button to restore these 
defaults.

There is an Optimize Performance for drop down list box that 
presents a list of predefined performance optimizations. You 
can change the optimization for the array by selecting any 
option from the list. When making a selection from the list box, 
other applications may be optimized as well. An entire list of 
all applications that fit within the optimization scheme of the 
selection are displayed in the read-only Optimized Applica-
tions list box. 

6 To edit the cache settings, click the Edit button. Refer to Setting 
Cache Parameters for Performance Optimization on page 7-5.

If you have an existing array with cache settings that do not 
correspond to any Performance Optimization, you will be 
prompted when you open the Performance Setting dialog to 
create a new Performance Optimization for the existing values or 
to choose an existing option. If you choose to create a new Per-
formance Optimization, the Performance Setting dialog 
appears, with no name in the edit field. You can then enter a 
unique name for Performance Optimization and save it.

7 Click OK to enter changes to the caching options.

The new optimization file is saved to the disk when you exit 
the application. The optimization file, perfset.cio, can be cop-
ied into the CI/O installation directory on other systems to 
enable its definitions there.
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Note: If the array currently has cache enabled and you 
click Restore Defaults, the current amount of cache 
allocated to the cache size entry field will be restored. 
If you click Restore Defaults when an array is being 
created or when the cache of an existing array is dis-
abled, the total unused cache will be restored to the 
cache size entry field.

Setting Cache Parameters for Performance Optimization
A cache block can be assigned to a specific application for each array 
assigned. In the Optimized Performance for list box, the default appli-
cation is displayed.

Note: If you open a Performance Setting that has been desig-
nated as read-only, you will only be allowed to select or 
deselect the use as default checkbox. However, you can cre-
ate a new performance setting under a different name with 
complete access to all parameters.

Figure 7-2. Performance Setting Dialog Box
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■ Use as default causes this performance setting to be the default 
setting used in creating new arrays and enabling cache on an 
array.

■ Read and Write caching options are defined in terms of blocks, 
not KBytes.

– The block is the basic unit of measurement, in KBytes, for 
data stored in a cache.

– The Cache block size is the unit of cache memory. The num-
ber of blocks multiplied by the cache block size equals the 
physical amount of memory on the array adapter that is 
used for this system device. For example, if the cache block 
size is 4 KBytes and there are 256 blocks in the cache, the 
total cache is 1024 KBytes.

Read Caching

Caution: Changing the Read cache settings will affect your 
desktop system’s performance.

There are two Read caches: the Demand Cache and the Look-ahead 
Cache. Options for these caches can be adjusted separately for each 
array on your desktop system.

■ The Demand Caching setting defines the maximum Read 
command size (stated as a number of data blocks) that will be 
cached. Demand Caching can greatly improve I/O perfor-
mance if your application typically reads data and then reads it 
again soon afterwards. For example, if Demand Caching is set 
to 4 blocks and the operating system issues a Read command 
for 4 blocks of data, all of the demand data is cached. However, 
if the operating system issues a Read command for 5 (or more) 
blocks of data, none of the demand data is cached.

Figure 7-3. Read Caching
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■ The Look-ahead Caching factor is a multiplier to the com-
mand size that defines the maximum number of data blocks 
that will be stored in the Look-ahead Cache in addition to the 
amount of data requested by the Read command. Look-ahead 
caching can greatly improve I/O performance if your applica-
tion typically reads data in sequential blocks. For example, if 
Look-ahead caching is set to 16 and the operating system 
issues a read command, the demand data is cached if the com-
mand is less than or equal to 4 blocks, and the next (sequential) 
16x4 blocks of data is stored in the Look-ahead Cache.

Write Caching

Caution: Changing the Write cache settings will affect your 
desktop system’s performance.

There are two Write caches: the Write-back Cache and the Write-
through Cache. Options for these caches can be adjusted separately 
for each array on your desktop system.

■ The Write-back Caching setting defines the maximum Write 
command size (stated as a number of data blocks) that will be 
cached in the Write-back Cache. When the Write command is 
issued, the data is quickly written to the cache. When the 
buffer is needed or when there is free time on the bus, the data 
is written from the cache to the disk. For example, if Write-back 
Caching is set to 4 blocks and the operating system issues a 
command to write up to 4 blocks of data, the data is stored in 
the Write-back Cache until it can be written to disk. However, 
if the operating system issues a Write command for 5 (or more) 
blocks of data, nothing is stored in the Write-back Cache.

Figure 7-4. Write Caching
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Caution: It is possible for data to be lost if the power to 
the desktop system is interrupted while the data is in 
the Write-back Cache, before it is written to disk. To 
avoid this risk, set this parameter to zero. If you do use 
Write-back Caching, we recommend that you back up 
your system data regularly and/or use an uninter-
ruptable power supply (UPS).

– Write-through Caching is the same as Write-back Caching, 
except that the data is immediately transferred from the 
cache to disk before sending the status to the host system. 
The difference between the Write-back Caching setting and 
the Write-through Caching setting defines the maximum 
Write command size beyond which the write data will not 
be cached at all. The data is written to disk and also stored 
in the cache. This enables faster I/O performance if the 
application needs to read the data that was recently writ-
ten. The Write-through Caching setting must always be 
greater than the Write-back Caching setting.

Graphing System Performance
Adaptec CI/O Management Software allows you to view dynami-
cally updated performance graphs for the Adaptec ARO-1130CA2 
and for devices that it controls. You can use this information to eval-
uate your desktop system’s I/O performance and, possibly, to 
improve performance by changing the caching parameters.

Follow these steps to view a graph of system performance:

1 Open the Storage Configuration window and select the icon of 

the array adapter , array , channel , or 

disk whose performance you want to graph. Click the 
Operations button.
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2 When the Operations dialog box appears, click the  
button. The CI/O Profiler window appears, as shown in 
Figure 7-5.

3 View the information on the graph. If you selected an RAID 
card, the graph shows information for all devices controlled by 
the RAID card. Figure 7-5 shows an area graph for a selected 
array. The graph displays the percentage of total Read cache 
hits compared to the total number of read commands.

– A Read cache hit occurs when the operating system issues 
a Read command for data that is in the Demand cache or 
the Look-ahead cache.

– A Write cache hit occurs when the operating system issues 
a Read command for data that is in the Write-back or Write-
through cache.

4 Perform any of the following operations on the graph (if the 
toolbar does not appear, select Toolbar from the View menu):

Figure 7-5. CI/O Profiler Window
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– Pause the updating of the graph by clicking the  but-
ton on the toolbar.

– Resume the updating of the graph by clicking the  
button on the toolbar.

– Toggle the auto-scaling feature on or off by clicking the 

 button on the toolbar.

– Zoom in for a closer look at the graph data by clicking the 

button on the toolbar, or zoom out by clicking the 

 button.

– Toggle the horizontal and vertical graph grid on or off by 

clicking the  button on the toolbar. (You can toggle the 
horizontal and vertical grids separately in the Show sec-
tion of the Profiler Graph Properties dialog box, as 
described on page 7-13.)

– Clear all data from the graph by clicking the  button 
on the toolbar. The graph will continue updating with new 
data.

– Save a graphic image of the current graph to the Windows 
Clipboard by selecting Copy Graph from the Edit menu. 
You can then paste the image into another application and 
print it.

5 If you want to change the graphing options, such as the type of 
data displayed or the measurement scale of the data, click the 

 button on the toolbar and follow the directions in the 
next section.

6 Select Exit from the File menu to close the CIO Profiler. If you 
wish, you can select a different array or disk in the Storage 
Configuration window and open a new graph for that device.
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CI/O Profiler Performance Tips
CI/O Profiler graphs will update more efficiently and use less mem-
ory if you follow these tips:

■ Use Line and Area graphs with the Hybrid updating option

■ Keep the profiler window small to reduce updating overhead.

■ Change the display color palette to 256 colors or 16 colors.

■ Increase the Update interval to 3, 4, or 5 seconds.

Changing the Graphing Options

To change the graphing options in the CI/O Profiler, click the  
button on the toolbar. The Profiler Graph Properties dialog box 
appears, as shown in Figure 7-6.

Here is a brief description of the graph properties you can change in 
this dialog box.

Figure 7-6. Profiler Graph Properties Dialog Box
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■ Measurement: You can select these options from the drop-
down Measurements menu:

– Cache hits: select this measurement to display the amount 
(or percentage) of total Cache hits compared to the total 
Read commands.

– Reads in bytes: select this measurement to display the total 
number of Read commands, as measured in MBytes or 
KBytes, not as a percent.

– Reads sorted by request size: select this measurement to 
display a histogram of the total number of Read com-
mands. The histogram has twelve data points along the 
horizontal axis (X-axis), ranging from 512 bytes to 
> 1 MByte. A dynamically changing bar of data above each 
data point shows the percentage of Read commands in 
each size category. By observing the histogram, you can see 
which sizes of Read commands are issued most often. You 
may be able to use this information to change the size of 
the Read/Write caches to enable more cache hits.

– Writes in bytes: select this measurement to display the total 
number of Write commands, as measured in bytes, not per-
cent. (You can select either MBytes of KBytes as the scale of 
measurement.)

– Writes sorted by request size: select this measurement to 
display a histogram of the total number of Write com-
mands. The histogram has twelve data points along the 
horizontal axis (X-axis), ranging from 512 bytes to 
> 1 MByte. A dynamically changing bar of data above each 
data point shows the percentage of Write commands in 
each size category. By observing the histogram, you can see 
which sizes of Write commands are issued most often. You 
may be able to use this information to change the size of 
the Write caches to enable more Write cache hits.

■ Graph Type: Depending on which measurement you select, 
some of the following graph types are available (not all types 
are available for each measurement):

– Line: shows a simple line graph with a data point every 
second.
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– Cluster Bar: shows a cluster of four small color-coded bars 
for each data point—one bar representing each of the four 
caches. (Supported by Cache Hits graph only.)

– Stacked Bar: shows a bar graph with one composite bar for 
each data point. Data from each cache is represented as a 
separate, color-coded segment of the bar. (Supported by 
Cache Hits graph only.)

– Area: (see Figure 7-5) Similar to a line graph, but with the 
area beneath the line filled in.

– Histogram: this is the only supported graph type for Reads 
sorted by request size or Writes sorted by request size. 
(Histograms are described above, under Measurement.)

– Bar: shows a single, non-composite bar for each data point, 
representing the total number of Reads and Writes.

■ X-Axis: You can select these options for the X-Axis (horizontal 
axis):

– Data Points: the number of data sampling points displayed 
across the X-axis of the graph. Select a number from the 
drop-down menu or type a whole number.

Note: The actual display of data points may vary 
somewhat, depending on the size of the graph on 
the screen. Data points are fixed at twelve for his-
tograms and cannot be changed.

– Update Interval: The interval, in seconds, at which Read 
and Write data is sampled and updated. We recommend 
that you select a 2-second update interval. You can type a 
different whole number or select a number from the drop-
down menu.

– Time Labels: select the check box to display the time labels 
below the graph or de-select it to hide them.

■ Show: select or deselect the check boxes to display or hide the 
following:

– X-Axis grid: the horizontal grid lines

– Y-Axis grid: the vertical grid lines
7-13



Adaptec Array1000CA2 Family Array Management Guide
– Object Info bar: The Object Info bar, which appears below 
the toolbar (see Figure 7-5), lists information about the 
device that is being graphed.

– Averages: only supported by bar graphs. When selected, 
this option displays a dotted-line, color-coded running 
average of the data that is displayed on bar graphs.

■ Y-Axis: You can select these options for the Y-Axis (vertical 
axis). Not all options are supported for all types of graphs:

– Limit: To limit the maximum range of the Y-axis, select the 
Limit check box and type or select a maximum number. If 
you do not set an upper limit, the scale of the axis changes 
dynamically to adjust to the peak data value shown on the 
graph. These data “spikes” may make the smaller data val-
ues on the graph more difficult to read, so you may wish to 
limit the upper range of data shown.

– Unit: Specifies the unit of measurement used on the Y-Axis:

If the graph is displaying Cache hits, only Percent is 
supported.

If the graph is displaying Reads in bytes or Writes in 
bytes, you can select KBytes or MBytes.

If the graph is displaying Reads sorted by request size or 
Writes sorted by request size, only Percent is supported.

– Second Y-Axis: If selected, this option displays a second set 
of Y-axis labels on the right side of the graph.

■ Updating Options: You can select the following options to 
control how the selected graph is updated on the screen:

– Sweep: When this option is selected, data on the graph is 
filled in starting from the left and moving to the right. 
When the entire graph is filled in, the data starts in again 
on the left, overwriting the previous data. A small vertical 
hash mark at the top of the graph marks the most recently 
updated data point.

– Scrolling: When this option is selected, data on the graph is 
filled in starting from the right and scrolling to the left 
across the graph. Data then scrolls off the left side of the 
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graph and disappears. New data continues to appear on 
the right.

– Hybrid: This updating option combines elements of Sweep 
and Scrolling. Data fills in the graph starting from near the 
right edge, scrolls to the left, and disappears from the 
screen. The scrolling occurs in such a way that there is usu-
ally an open margin on the right side of the graph.

■ Colors: Click this button to display the Graph Colors dialog 
box. You can change the background color of the window and 
the graph. You can also change the colors in which the various 
kinds of data are displayed in the graph.

Other Performance Tips
■ To achieve the best array I/O performance, we recommend 

that you use disks of the same capacity and same model in an 
array.

■ You can optimize array I/O performance by selecting a RAID 
level for the array that best meets your needs for data reliabil-
ity, read/write performance, and capacity utilization. In gen-
eral, you can achieve the best I/O performance by striping 
data across several disks in an array. (See Selecting a RAID Level 
for an Array on page 9-7 for more information.)

❒
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Setting Security Options
Adaptec CI/O Management Software has simple but effective pass-
word protection to prevent unauthorized changes to array configu-
ration. Users who know the password can view array information 
and can issue commands to add and delete arrays, add and delete 
spares, and make other changes to array configuration. Users who 
do not know the password can view array configuration informa-
tion but cannot change it.

Setting the Initial Password
Follow these steps to set the initial Adaptec CI/O Management Soft-
ware password after installing the program:

1 Double-click the  icon in the Adaptec CI/O Manage-
ment Software group to start the program.
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2 Select Change Password from the View menu. The Change 
Password dialog box appears, as shown in Figure 8-1.

No Old Password is required, because none has yet been 
defined.

3 Type the new password in the New Password field.

Passwords are case sensitive and can be up to 16 characters 
long, including the characters A-Z, a-z, and 0-9. Spaces are not 
allowed. Long passwords with a mixture of numerals and let-
ters provide better security. Do not use obvious passwords like 
your name, the name of a family member, your birthday, your 
social security number, etc.

4 Type the new password again in the Confirm Password field.

5 Click OK to register the initial password.

Changing the Password
Follow these steps to change the Adaptec CI/O Management Soft-
ware password:

1 Select Change Password from the View menu. The Change 
Password dialog box appears, as shown in Figure 8-1.

2 Type the existing password in the Old Password field.

3 Type the new password in the New Password field.

Figure 8-1. Change Password Dialog Box
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Passwords are case sensitive and can be up to 16 characters 
long, including the characters A-Z, a-z, and 0-9. Spaces are not 
allowed. 

4 Type the new password again in the Confirm Password field.

5 Click OK to accept the new password.

Setting Password Time-out Preferences
The password time-out preferences allow you to control the way in 
which users are prompted to enter the Adaptec CI/O Management 
Software password when they issue commands to change the Dell 
workstation’s array configuration.

Follow these steps to change the Adaptec CI/O Management Soft-
ware password time-out preferences:

1 Click the  button on the toolbar. The Preferences dialog 
box appears.

2 Select one of the three Password Time-out preferences listed on 
the right of the dialog box. Here is a description:

– No Password Time-out: Requires you to enter the pass-
word only the first time (during each session) that you issue 
a command to change array configuration. This option pro-
vides less security than the others: if you leave your work-
station unattended after entering the password, another 
person can issue commands from the workstation without 
being prompted for the password.

– Always Require Password: Requires you to re-enter the 
password every time you issue a command to change array 
configuration.

– Enter Password Time-out Interval: Requires you to re-
enter the password at the stated time-out interval, when-
ever you issue commands to change the array configura-
tion. For example, suppose that the time-out interval is 10 
minutes. You start the program at 9:00 and issue a com-
mand to create a new array. You are prompted to enter the 
password before the command is accepted. After entering 
the password, you issue a command at 9:05 to add spares 
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to the spare pool; no password is required. At 9:16 you 
issue a command to delete an array; since you are beyond 
the 10-minute interval, you are prompted again to enter the 
password before the command is executed.

3 Click OK to accept the password time-out change. You may be 
prompted to enter the password at this point.

❒
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Managing Arrays and 
Spares
This chapter has information on what to do when you need to 
replace a failed drive, physically reconfigure the disks in your desk-
top system, and perform other tasks.

Responding to a Critical Array
A fault-tolerant RAID 1 array enters Critical status if one disk in the 
array fails. The array continues to operate normally, but you will 
lose data if the other disk in the array fails.

If a spare disk is available, the array management software will 
reconstruct the Critical array automatically. When the reconstruct is 
complete, the array returns to Fault-tolerant status. If no spare disk 
is available, you should respond immediately to minimize the possi-
bility of data loss. The most effective strategy is prevention: be sure 
that arrays are always protected by a spare pool or by dedicated 
spares!

In addition, you should monitor the status of arrays at all times with 
Adaptec CI/O Management Software to detect arrays whose status 
is Critical. You can tell that an array is in critical status if its icon in 

the Storage Configuration window looks like this .
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Follow these steps to return a Critical array to Fault-tolerant status:

1 Click the array icon  and observe the disk icons of the 
array members on the left of the screen. One of the icons 

should look like this , indicating that the disk has failed.

2 Determine which of the disks inside the desktop system has 
failed.

3 Exit from Adaptec CI/O Management Software, exit from 
Windows, turn OFF the power to the workstation, disconnect 
the power cord, and remove the cover from the computer case.

WARNING: Be sure that you have turned OFF the desktop 
system and disconnected the power cord before you con-
tinue. See the system documentation for instructions on 
opening the computer case.

A disk may have “failed” for one of these reasons:

a The disk has physical malfunctioned.

b The power cord or SCSI cable has accidentally been discon-
nected from the disk.

4 If the disk has actually failed (malfunctioned), replace it with a 
good disk. If the power cord or SCSI cable was accidentally 
disconnected from the disk, reconnect it.

5 Replace the cover of the computer case, reconnect the power 
cord, and turn the desktop system ON.

6 Start Windows, and start Adaptec CI/O Management Soft-
ware.

7 Select the icon of the disk you replaced (or the disk you recon-
nected) and issue a Create a Spare command. (See Creating 
Dedicated Spares or a Spare Pool on page 3-12.)

8 When the spare has been created, select the array icon and 
issue a Reconstruct command, if necessary (it is possible that 
the reconstruct will start automatically at this point).
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When the reconstruct is completed the array is in Fault-tolerant sta-

tus again, and the array icon will look like this .

Replacing an Active Array Member
Follow these instructions if you want to remove an array member of 
a RAID 1 array that has not actually failed and replace it with 
another disk drive. You may want to do this if the drive has 
generated a S.M.A.R.T. predictive failure alert.

Note: The following procedure applies to disk drives in an 
external drive enclosure. If the array disks are inside the 
computer case, you need to power down the computer and 
remove the cover in order to replace a disk.

1 Perform a Down operation on the array member you want to 
replace (see Downing a Drive on page 5-16).

2 If the array member is in an enclosure that supports hot 
swapping, remove it and replace it with another disk drive.

3 If the array member is not in an enclosure that supports hot 
swapping, pause I/O (see Pausing I/O to an Array Disk Drive on 
page 5-18).

4 Remove the disk drive and allow I/O to resume.

5 Pause I/O again, insert the replacement drive, and allow I/O 
to resume.

The data from the array member will be reconstructed on the 
new disk drive. If a spare disk was already available, the 
reconstruct operation was begun automatically when you 
downed the array member.
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Responding to an Off-line Array
You can tell that an array is in off-line status if the array icon in the 
Storage Configuration window is grayed out. There are several rea-
sons for an array going off-line, as described below:

■ Both disks of a mirrored pair in a Critical RAID 1 array have 
failed.

If this happens, delete the off-line array, create a new array, and 
restore the data from your most recent backup. You cannot 
recover the array data if a second disk fails.

■ You were trying to replace a failed disk in a Critical RAID 1, 
array, but you mistakenly removed the wrong disk.

If this happens, reinsert the drive you mistakenly removed, 
issue a Rescan command, and reboot the computer. Then 
replace the correct disk and reconstruct the array.

■ A cable to a good drive in a RAID 1 array accidentally became 
disconnected, and the other disk of the mirrored pair had 
already failed.

If this happens, reconnect the cable, issue a Rescan command, 
and reboot the computer. Then replace the failed disk and 
reconstruct the array.
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Notes on Replacing Disk Drives
■ To minimize the possibility of data corruption, we recommend 

that when you replace a disk drive you use a drive of the same 
capacity or larger.

■ You must replace a device with the same kind of SCSI device 
when you are using Pause I/O. You should not, for example, 
replace a disk drive with a CD-ROM drive while I/O is 
paused.

■ When you replace a failed array member with a good disk 
drive with the same SCSI ID, and you want to make this disk a 
member of the array, you should first designate the new disk 
as a dedicated spare. A reconstruct should start automatically, 
using the new dedicated spare.

■ We recommend that you remove old or defective disk drives 
from the system as soon as possible. You must low-level format 
a removed drive before you try to use it again.

Replacing a Spare
Follow these steps to replace a spare drive that is recognized as good 
by Adaptec CI/O Management Software:

1 Delete the spare (see Deleting a Spare on page 3-15).

2 If the spare is in an enclosure that supports hot swapping, 
remove the spare disk drive and replace it with another disk 
drive. Then skip to step Step 6.

3 If the spare is not in an enclosure that supports hot swapping, 
pause I/O (see Pausing I/O to an Array Disk Drive on page 5-18).

4 Remove the spare and allow I/O to resume.

5 Pause I/O again, insert the replacement drive, and allow I/O 
to resume.

6 Use Adaptec CI/O Management Software to mark the new 
disk drive as a dedicated spare or a pool spare (see Creating 
Dedicated Spares or a Spare Pool on page 3-12).

Follow these steps to replace a spare drive that is recognized as 

down  by Adaptec CI/O Management Software. (This rarely 
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occurs. Usually, if a spare disk fails a regular test of spares, CI/O 
automatically deletes the spare disk.)

1 If the down spare is in an enclosure that supports hot 
swapping, remove the spare disk drive and replace it with 
another disk drive. Then skip to step Step 5.

2 If the spare is not in an enclosure that supports hot swapping, 
pause I/O (see Pausing I/O to an Array Disk Drive on page 5-18).

3 Remove the spare and allow I/O to resume.

4 Pause I/O again, insert the replacement drive, and allow I/O 
to resume.

5 Use Adaptec CI/O Management Software to mark the new 
disk drive as a dedicated spare or a pool spare (see Creating 
Dedicated Spares or a Spare Pool on page 3-12).

You may need to low-level format the spare disk that you 
removed before you can try to re-use it.
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Selecting a RAID Level for an Array
RAID means Redundant Array of Independent Disks. An array is a 
grouping of disks that, by means of array management software, 
appears to the computer’s operating system as one large disk. Part 
of the storage capacity of RAID 1 arrays contains redundant infor-
mation about the user data on the array1. If one array disk fails, the 
contents of the disk can be regenerated on a new disk from the 
redundant information on the other array disk.

Compared with single disks, arrays can provide one or more of 
these benefits:

■ improved Read and Write I/O performance by striping data 
across the disks in the array. This allows data to be read from or 
written to two or more disks simultaneously.

■ improved data reliability by storing redundant data to regener-
ate a failed array disk, as described above. (This applies to 
RAID 1 arrays; RAID 0 arrays do not store redundant data.)

■ improved capacity utilization by allowing you to manage a 
large number of disks as if they were one large disk. This can 
simplify the tasks of backing up data, creating directories, etc.

You can create dedicated spare disks for each RAID 1 array. You can 
also create a pool of spares that can be used by a RAID 1 array con-
trolled by the Adaptec RAID card.2

The array management software and firmware support RAID 0 and 
RAID 1 arrays. The advantages, disadvantages, and requirements of 
these RAID levels are as follows:

1 RAID 0 arrays, which do not store redundant data, are an exception to this 
definition.

2 A disk in a spare pool can only be used to replace a failed disk in an array 
if it is at least as large as the smallest disk in the array.
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RAID 0 Arrays
Maximum Disks Allowed: 16
Minimum Disks Allowed: 13

In a RAID 0 array, data is distributed, or striped, across the disks in 
the array. The capacity of the array is approximately equal to the 
combined capacity of the physical disks. The I/O performance of a 
RAID 0 array is much better than that of a single physical disk 
because multiple reads and writes can be handled in parallel and 
because when large files are accessed the striped data is retrieved 
simultaneously from several disks.

RAID 0 arrays do not store redundant data and therefore are not 
true RAID applications. If one disk fails, the entire array fails and all 
data is lost. This means that the fault tolerance of a RAID 0 array is 
less than that of any single disk in the array. The term RAID 0 is 
widely used for these arrays, however, because they are conceptu-
ally similar to true RAID applications.

RAID 1 Arrays
Maximum Disks Allowed: 2
Minimum Disks Allowed: 2

RAID 1 arrays use a single pair of disks. They are called mirrored 
arrays because both disks in the pair contain the same data. When 
data is written to a RAID 1 array it is written to each disk in the pair. 
The read performance of a RAID 1 array can be much better than 
that of a single disk, while the write performance is slightly worse. 
Mirrored arrays are highly reliable because the data is still safe if one 
disk in the pair fails. They are more costly, however, because you 
only get one disk of actual storage capacity from the pair of disks.

❒

3 One-disk RAID 0 arrays are used only to control the virtual device order of 
single disks.
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Configuration Settings
This appendix describes the configuration variables that control the 
appearance of the Adaptec CI/O Management Software user inter-
face and the way in which array and system operations are carried 
out. The variables controlling the ArrayConfig program are the 
arconfig.ini file. The variables controlling the user interface appear-
ance are in the Windows NT registry. The other variables are defined 
in a file called iomgr.ini. 

Many of the variables are configured for you once you install the 
software or start the program. If you are an advanced user and you 
want to customize your settings, you can edit the variables in the NT 
registry, or you can open iomgr.ini or arconfig.ini in a text editor and 
manually make changes.
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arconfig.ini
The arconfig.ini file is located on the ArrayConfigCA2 diskette. The 
variables in this file are described below. Variables and their values 
are not case-sensitive.

ExpressSetup=
When set to Yes (the default) this variable causes the Express Setup 
wizard to be displayed when ArrayConfigCA2 starts. When set to No, 
the Custom Setup Main Menu appears when ArrayConfigCA2 starts.

WriteSame=
This variable, when enabled, can speed up the formatting of array 
disks in some systems when you create a new array. By default, the 
line WriteSame=Yes is included in the arrayconfig.ini file, but it is 
remarked out and therefore disabled. If you want to enable 
WriteSame, open arconfig.ini in a text editor, delete the letters rem at 
the beginning of the line, and save the file. The next time you create an 
array, it should take less time to format the disks.

SparePool=
This variable enables or disables the option of creating a spare pool 
in ArrayConfigCA2. This variable should be set to No, because this 
version of ArrayConfigCA2 does not support spare pools. (You can 
create a spare pool with Adaptec CI/O Management Software.)
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iomgr.ini
The iomgr.ini file is located in the directory in which Adaptec CI/O 
Management Software is installed. The section name, for example 
[ARRAYOPERATIONS], and the variables under each section are 
described below.

[ARRAYOPERATIONS]

RecreatePriority=
This variable specifies the priority of the automatic Reconstruct opera-
tion. Valid values are Low, Medium, or High. The default is Medium.

VerifyIfDirty=
This variable specifies whether you want to start the Verify opera-
tion if the array is dirty (the array was not shut down properly). 
Valid values are Yes or No. The default value is Yes.

DriverMonitoringFrequencyInSecs=
This variable specifies the maximum interval in seconds before 
Adaptec CI/O Management Software polls the driver. Any number 
of seconds can be specified; small values may affect performance, 
large values (greater than 10 seconds) may affect responsiveness to 
problems. The default value is 5.

[SYSTEM]

ServerLogSizeInMegabytes=
This variable is used to limit the size of the Historical Log database 
file. Information is deleted from the end of the database file if it 
grows beyond the size specified by the parameter. The size can be 
specified in increments of 1 MByte, up to a maximum of 10 MBytes.

StatisticsCollectionInterval=
This variable specifies the interval at which system statistics will be 
collected, assuming that the driver supports statistics collection. Val-
ues must be entered as whole numbers. The default value is 1.

WarnAfterFirstPFAEvent=
If set to Yes, this variable specifies that if SMART events (PFA) are 
received from any drive the first event will be reported as a Critical 
event and all events after that will be reported as Warning events. If 
set to No, all SMART events will be reported as Critical. The default 
is Yes.
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[TASKS]

TestAllSpares=
This variable schedules the TestAllSpares operation. These jobs are 
not written to the Scheduler Database and are scheduled every time 
iomgr.exe is started. The default setting is to test all spares at 
2:00 A.M. daily. Valid values are 

■ Yes,H—Starts test every hour on the hour. For example, 
TestAllSpares=Yes,H

■ Yes,D,Time—Starts test daily at a specified time, stated in 24-
hour time format. For example, TestAllSpares=Yes,D,11:34.

■ Yes,W,Day of the week,Time—Starts test weekly at a specified 
day and time (Day of the week: 0=Sun, 1=Mon, 2=Tues., etc.). 
For example, TestAllSpares=Yes,W,2,11:34 (starts every week 
on Tuesday at 11:34).

■ No—No tests are scheduled. For example, TestAllSpares=No.

Note: A default Test All Spares activity is scheduled. Since 
only one Test All Spares activity is permitted per system, you 
must first delete the default Test All Spares activity before 
adding your own.
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User Interface Variables
The Adaptec CI/O Management Software user interface variables are 
located in the Windows NT registry under 
HKEY_LOCAL_MACHINE\SOFTWARE\Adaptec\Adaptec CI/O 
Array Management Software:

■ Config Path: REG_SZ: configs.dat
This is the storage path for the configuration file.

■ Display Activity: REG_DWORD: 0
If the value is non-zero, the application will display the Activ-
ity Monitor window on startup.

■ Display Config: REG_DWORD: 0x2
If the value is non-zero, the application will display the Storage 
Configuration window on startup.

■ Display Server Log: REG_DWORD: 0
If the value is non-zero, the application will display the His-
toric Event Log window on startup.

■ Display Server View: REG_DWORD: 0
Not applicable to the workstation version of Adaptec CI/O 
Management Software.

■ Notifications: REG_DWORD: 0
Popup Box is 0x1, Beep is 0x2, Flash Titlebar is 0x4, and None 
is 0x0. These values may be OR’ed together.

■ Server Name: REG_SZ: 
Not applicable to the workstation version of Adaptec CI/O 
Management Software.

■ Severity: REG_DWORD: 0xd
Informational is 0x1, Warning is 0x4, and Critical is 0x8. These 
values may be OR’ed together.

■ Start Date: REG_SZ: 1/1/1990

■ Start Time: REG_SZ: 00:00:00

❒
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	Starting the Program
	1 Start Windows�NT.
	2 Double-click the icon in the Adaptec CI/O Management Software group to start the program.
	3 If the Storage Configuration window does not open automatically, open it by clicking the icon o...

	Creating an Array
	1 Start Adaptec CI/O Management Software and open the Storage Configuration window, as described ...
	Figure 3-1. Storage Configuration Window

	2 Before you start defining the new array, decide what RAID level you want to use, how many disks...
	PERFORMANCE TIP:

	Minimum # of Disks Allowed
	Maximum # of Disks Allowed
	Dedicated Spares Allowed
	1
	16
	None
	2
	2
	1 or 2
	3 Select disks for the new array by clicking disk icons that have the word Single beneath them, a...
	Figure 3-2. Selecting Array Members

	4 Click the Create Array... button. The Create Array dialog box appears, as shown in Figure�3-3.
	Figure 3-3. Create Array Dialog Box

	5 Type a name for the new array. The name can be up to 15 characters, including spaces and any ot...
	6 Select a RAID level for the array by clicking one of the buttons on the left. The bar graphs on...
	7 (Optional) If you created a RAID�1 array, select one or two dedicated spares for it from disks ...
	8 (Optional) Click the Advanced... button to examine or change the Advanced Array options. The Ad...
	9 The Optimize Performance for list box displays the default application for performance optimiza...
	10 Click OK and then click Yes to confirm that you want to create the array. You will see error m...
	11 Wait until the new array is initialized. An icon like this for the new array appears in the ri...
	12 Exit from Adaptec CI/O Management Software. Then reboot the desktop system. (You cannot use th...
	Setting Advanced Array Options
	Figure 3-4. Advanced Array Options Dialog Box

	Making an Array the Boot Device
	1 Start Adaptec CI/O Management Software and open the Storage Configuration window, as described ...
	2 Click the icon in the right-hand part of the window for the array that you want to make bootable.
	3 Click the Operations button.
	4 Click the button.
	5 When the message appears, click OK to confirm that you want to make this array the boot device.
	6 Exit from Adaptec CI/O Management Software. If the selected array does not already have a boota...
	7 Install the operating system on the array. See the Installation and Hardware Guide for more �in...

	Deleting an Array
	1 Start Adaptec CI/O Management Software and open the Storage Configuration window, as described ...
	2 Click the icon in the right-hand area of the window for the array you want to delete.
	3 Click the Operations button.
	4 When the Array Operations dialog box appears, click the button to delete the array.
	5 When the confirmation message appears, click OK to confirm that you want to delete the array.

	Initializing an Array
	1 Start Adaptec CI/O Management Software and open the Storage Configuration window, as described ...
	2 Click the icon of the array you want to initialize. The Operations button becomes active.
	3 Click the Operations button.
	4 When the Array Operations window appears, click the button.
	5 When the confirmation message appears, click Initialize to confirm that you want to initialize ...

	Creating Dedicated Spares or a Spare Pool
	1 Start Adaptec CI/O Management Software and open the Storage Configuration window, as described ...
	2 Select the disk you want to configure as a spare by clicking on its icon in the left-hand part ...
	3 Click Create Spare... The Create Spare dialog box appears, as shown in Figure�3-5. A list of al...
	Figure 3-5. Create Spare Dialog Box

	4 If you want to dedicate the spare to a specific array, select Dedicated To and click the array ...
	5 Click OK to create the spare. A warning message appears if you select a disk that has a partiti...

	Deleting a Spare
	1 Start Adaptec CI/O Management Software and open the Storage Configuration window, as described ...
	1 Click the icon in the Array part of the window for the spare you want to delete. The icons for ...
	2 Click Operations
	3 When the Spare Operations dialog box appears, click the Delete button.
	4 When the confirmation message appears, click OK to confirm that you want to delete the spare.





	4
	Viewing Array, Device, and System Information
	1 Select Configuration from the View menu, or click the icon on the toolbar.
	2 When the Storage Configuration window appears, double- click the icon that represents the devic...
	Rescanning the Computer
	1 Click the button on the toolbar. The Storage Configuration window appears.
	2 Click the Rescan button.
	3 When the message appears, click Yes to confirm that you want to rescan the system. When the res...
	4 Click OK when the message appears indicating that the rescan was completed successfully.

	Viewing Array Information
	Figure 4�1. Array Information Dialog Box

	Viewing Spare Information
	Figure 4�2. Spare Information Dialog Box

	Viewing RAID Card Information
	Figure 4�3. Controller Information Dialog Box

	Viewing Channel Information
	Figure 4�4. Channel Information Dialog Box

	Viewing SCSI Device Information
	Figure 4�5. SCSI Information Dialog Box

	Viewing System Event Information
	1 Click the button on the toolbar. The Historic Event Log appears, as shown in Figure�4�6.
	Figure 4�6. Historic Event Log Window

	2 View the system event information. New entries are added to the top of the list as they occur. ...
	3 To view detailed information about a log entry, �double-click the entry, or highlight the entry...
	4 Click Filter to change the message filter options. These changes apply only while the window is...
	5 Click Clear All to delete all existing log entries. Click Save As to save the log to a file.
	6 Click OK to All to acknowledge all outstanding events for the system.
	7 Close the window when you are finished viewing log entries, or minimize it as an icon on the sc...
	Interpreting and Responding to System Event Messages

	Setting Preferences
	1 Click the button. The Preferences dialog box appears, as shown in Figure�4�7.
	Figure 4�7. Preferences Dialog Box

	2 Click the Notification button to change the way in which you are alerted of event notifications...
	Figure 4�8. Event Notification Options Dialog Box

	3 Click the Filter button to view the Log Filter dialog box, as shown in Figure�4�9. Select or de...
	Figure 4�9. Log Filter Dialog Box

	4 Click OK to change the option information or to close the Preferences dialog box. These setting...



	5
	Performing Operations on Arrays and Other System Devices
	1 Select Configuration from the View menu, or click the icon on the toolbar.
	2 When the Storage Configuration window appears, single-click an icon that represents an array , ...
	3 Click the Operations button. A dialog box appears with icons for the operations that you can pe...
	4 Click the button for the operation you want to perform. See the appropriate section of this cha...
	Performing Array Operations
	Reconstructing an Array
	1 Determine which array is in Critical status and which disk in the array has failed.
	2 Turn off the desktop system, disconnect the power cord, and open the computer case.
	3 Replace the failed disk with a good disk of at least the same storage capacity. Be sure that th...
	4 Close the computer case, reconnect the power cord, and turn on the desktop system.
	5 If you installed a new disk (or disks), make the disk into a spare by following the directions ...
	6 Select Configuration from the View menu. The Storage Configuration window appears.
	7 Click on the array icon that looks like this . The Operations button becomes active.
	8 Click the Operations button. The Array Operations dialog box appears, as shown in Figure�5-1.
	Figure 5-1. Array Operations Dialog Box

	9 Click the button. The Scheduler dialog box appears.
	10 Enter the required information for the Reconstruct operation in the Scheduler dialog box. You ...
	11 Select an Execution Priority - high, medium, or low.
	12 Click OK.
	13 When the message appears, confirm that you want to reconstruct the array member.
	14 Read the event notifications that appear in the Historic Event Log (they may also appear as po...

	Verifying Array Integrity
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on the array icon . The Operations button becomes active.
	3 Click the Operations button.
	4 When the Array Operations dialog box appears, click the button to verify the data on the array....
	Figure 5-2. Scheduler Dialog Box

	5 Leave the autofix box checked so that data mirroring mismatches will be corrected automatically.
	6 Select Immediate if you want to verify parity immediately, or select Scheduled if you want to s...
	7 If you select Scheduled, enter a start time, start day of the week, and other information. (See...
	8 Select an Execution Priority - high, medium, or low. This determines how much system resources ...
	9 Click OK to start the operation (if you selected Immediate) or to enter it on the list of sched...

	Pausing I/O on an Array
	1 Open the Storage Configuration window and select the icon of the array you want to pause.
	2 When the Array Operations dialog box appears, click the button.
	3 When the Pause I/O dialog box appears, enter a pause interval no greater than 120 seconds, and ...
	4 Remove the disk drive you want to replace. Data I/O resumes automatically at the end of the pau...
	5 Pause I/O again, entering a pause interval as described above.
	6 While I/O is paused, replace the disk drive you removed with a new disk drive. Data I/O resumes...

	Blinking Array Drive Lights
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on an Array icon in the right side of the dialog box. The Operations button becomes active.
	3 Click the Operations button.
	4 When the Array Operations dialog box appears, click the button.
	5 Look at the array enclosure to see which disks are members of the array.
	6 Click the Unblink all button in the Storage Configuration dialog box to stop the drive lights f...

	Reactivating an Off-line Array
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on the grayed-out icon of the off-line array. The Operations button becomes active.
	3 Click the Operations button.
	4 When the Array Operations dialog box appears, click the button.
	5 When the message appears, confirm that you want to reactivate the array. Be sure that any hardw...

	Changing an Array Name
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click the icon of the array whose name you want to change. The Operations button becomes active.
	3 Click the Operations button.
	4 When the Array Operations dialog box appears, click the button. The Change Name dialog box appe...
	5 Type the new array name and click OK.
	6 When the confirmation message appears, confirm that you want to change the array name. This cha...

	Forcing a Spare
	1 Be sure that one or more spares are available for the array. These can either be dedicated spar...
	2 Select Configuration from the View menu. The Storage Configuration window appears.
	3 Click on the icon of the array with the suspect disk. The Operations button becomes active.
	4 Click the Operations button.
	5 When the Array Operations dialog box appears, click the button. This button is grayed out if no...
	6 Select the disk that you want to replace.
	7 Click OK to replace this disk with a spare.
	8 When the confirmation message appears, confirm that you want to replace the disk with the spare...


	Performing Spare Operations
	Testing All Spares
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on the icon of any spare on the right side of the dialog box. The Operations button becom...
	3 Click the Operations button.
	4 When the Spare Operations dialog box appears, click the button. The Scheduler dialog box appear...
	5 Select Immediate if you want to test all spares immediately, or select Scheduled if you want to...
	6 If you select Scheduled, enter a starting time, starting day, and other information.
	7 Click OK to start the operation (if you selected Immediate) or to enter it on the list of sched...
	8 When the confirmation message appears, confirm that you want to test the spares.
	9 When the test is finished, look at the spare disk icons in the Storage Configuration window. Th...
	10 Replace any failed disks immediately with good disks of at least the same capacity.

	Blinking the Spare Drive Light
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click a Spare icon in the right side of the dialog box. The Operations button becomes active.
	3 Click Operations.
	4 When the Spare Operations dialog box appears, click the button.
	5 Look at the array enclosure to see which disk light is blinking.
	6 Click Unblink all in the Storage Configuration window to stop the drive light from blinking.


	Performing RAID Card Operations
	Optimizing RAID Card Performance
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on an RAID card icon in the left side of the dialog box. The Operations button becomes ac...
	3 Click the Operations button.
	4 When the Adapter Operations dialog box appears, click the button. A list of arrays controlled b...
	5 Select the array whose caching options you want to change and click the Caching button. (Each a...
	6 Change cache settings as needed. Follow the instructions in Using Read and Write Caching on pag...

	Graphing RAID Card Performance
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on an RAID card icon in the left side of the dialog box. The Operations button becomes ac...
	3 Click the Operations button.
	4 When the Adapter Operations dialog box appears, click the button. The CI/O Profiler window appe...
	5 Follow the instructions in Graphing System Performance on page�7�8. The information you will se...


	Performing SCSI Channel Operations
	Graphing SCSI Channel Performance
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on a SCSI channel icon in the left side of the dialog box. The Operations button becomes ...
	3 Click the Operations button.
	4 When the Channel Operations dialog box appears, click the button. The CI/O Profiler window appe...
	5 Follow the instructions in Graphing System Performance on page�7�8. The information you will se...


	Performing Disk Operations
	Blinking the Drive Light
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click a Disk icon in the left side of the window. The Operations button becomes active.
	3 Click Operations.
	4 When the Drive Operations window appears, click the button.
	5 Look at the array enclosure to see which disk light is blinking.
	6 Click Unblink all in the Storage Configuration dialog box to stop the drive light from blinking.

	Downing a Drive
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Select the icon of the disk you want to down.
	3 Click the Operations button.
	4 When the Drive Operations dialog box appears, click the button. If a spare is available, it rep...
	5 Wait until the Reconstruct operation is completed.

	Pausing I/O to an Array Disk Drive
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Select the icon of the disk you want to pause.
	3 Click Operations. When the Array Operations dialog box appears, click the button.
	4 When the Pause I/O dialog box appears, enter a pause interval no greater than 120 seconds, and ...
	5 Remove the disk drive you want to replace. Data I/O resumes automatically at the end of the pau...
	6 Pause I/O again, entering a pause interval as described above.
	7 While I/O is paused, replace the disk drive you removed with a new disk drive. Data I/O resumes...
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	Scheduling and Monitoring Array Operations
	Setting Scheduling Options
	1 Define a new scheduled operation: Reconstruct an Array, Verify Integrity of Array, or Test All ...
	Figure 6-1. Scheduler Dialog Box

	2 Select Immediate to perform the action immediately or Scheduled to schedule it for later.
	3 If you select Scheduled, select Once, Periodically, Daily, or Weekly. Enter other information s...
	4 Click OK to record the scheduling options. You may be prompted to confirm the activity.

	Viewing and Managing Scheduled Activities
	1 Select Activities from the View menu. The Array Activity Monitor window appears, as shown in Fi...
	Figure 6-2. Array Activity Monitor Window

	2 Select an activity icon from the left part of the window. Information about the activity is sho...
	3 If you want to change the priority of a Verify or Reconstruct operation that is currently runni...
	4 If you want to delete an activity that is not currently running, select its icon and click the ...
	5 If you want to abort a currently-running activity, select its icon and click the Abort button. ...
	6 Click the Watch button to open a small window to monitor the selected, currently running activi...
	Changing the System Time
	1 Delete all scheduled activities.
	2 Stop all Adaptec CI/O Management Software services and RPC services.
	3 Change the system time.
	4 Restart the Adaptec CI/O Management Software services and RPC services.
	5 Reschedule the scheduled activities.


	Monitoring Activities that are Running
	1 Select Activities from the View menu. The Array Activity Monitor window appears.
	2 Select the icon of a currently-running activity from the scrollable list at the top of the window.
	3 Click the Watch button. A small Watch window for this activity appears, as shown in Figure�6-3....
	Figure 6-3. Watch Window
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	Optimizing and Monitoring System Performance
	Using Read and Write Caching
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Select an array icon and Click the Operations button.
	3 When the Array Operations dialog box appears, click the button. The Optimize Performance dialog...
	Figure 7�1. Optimize Performance Dialog Box

	4 Read the general information at the bottom of the Optimize Performance dialog box. This include...
	5 Select or deselect the Caching Enabled check box. This is the top-level control for all caching...
	6 To edit the cache settings, click the Edit button. Refer to Setting Cache Parameters for Perfor...
	7 Click OK to enter changes to the caching options.
	Setting Cache Parameters for Performance Optimization
	Figure 7�2. Performance Setting Dialog Box
	Read Caching
	Figure 7�3. Read Caching

	Write Caching
	Figure 7�4. Write Caching



	Graphing System Performance
	1 Open the Storage Configuration window and select the icon of the array adapter , array , channe...
	2 When the Operations dialog box appears, click the button. The CI/O Profiler window appears, as ...
	Figure 7�5. CI/O Profiler Window

	3 View the information on the graph. If you selected an RAID card, the graph shows information fo...
	4 Perform any of the following operations on the graph (if the toolbar does not appear, select To...
	5 If you want to change the graphing options, such as the type of data displayed or the measureme...
	6 Select Exit from the File menu to close the CIO Profiler. If you wish, you can select a differe...
	CI/O Profiler Performance Tips
	Changing the Graphing Options
	Figure 7�6. Profiler Graph Properties Dialog Box


	Other Performance Tips
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	Setting Security Options
	Setting the Initial Password
	1 Double-click the icon in the Adaptec CI/O Management Software group to start the program.
	2 Select Change Password from the View menu. The Change Password dialog box appears, as shown in ...
	Figure 8-1. Change Password Dialog Box

	3 Type the new password in the New Password field.
	4 Type the new password again in the Confirm Password field.
	5 Click OK to register the initial password.

	Changing the Password
	1 Select Change Password from the View menu. The Change Password dialog box appears, as shown in ...
	2 Type the existing password in the Old Password field.
	3 Type the new password in the New Password field.
	4 Type the new password again in the Confirm Password field.
	5 Click OK to accept the new password.

	Setting Password Time-out Preferences
	1 Click the button on the toolbar. The Preferences dialog box appears.
	2 Select one of the three Password Time-out preferences listed on the right of the dialog box. He...
	3 Click OK to accept the password time-out change. You may be prompted to enter the password at t...
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	Managing Arrays and Spares
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	Managing Arrays and Spares
	Responding to a Critical Array
	1 Click the array icon and observe the disk icons of the array members on the left of the screen....
	2 Determine which of the disks inside the desktop system has failed.
	3 Exit from Adaptec CI/O Management Software, exit from Windows, turn off the power to the workst...
	a The disk has physical malfunctioned.
	b The power cord or SCSI cable has accidentally been disconnected from the disk.

	4 If the disk has actually failed (malfunctioned), replace it with a good disk. If the power cord...
	5 Replace the cover of the computer case, reconnect the power cord, and turn the desktop system on.
	6 Start Windows, and start Adaptec CI/O Management Software.
	7 Select the icon of the disk you replaced (or the disk you reconnected) and issue a Create a Spa...
	8 When the spare has been created, select the array icon and issue a Reconstruct command, if nece...

	Replacing an Active Array Member
	1 Perform a Down operation on the array member you want to replace (see Downing a Drive on page 5...
	2 If the array member is in an enclosure that supports hot swapping, remove it and replace it wit...
	3 If the array member is not in an enclosure that supports hot swapping, pause I/O (see Pausing I...
	4 Remove the disk drive and allow I/O to resume.
	5 Pause I/O again, insert the replacement drive, and allow I/O to resume.

	Responding to an Off-line Array
	Notes on Replacing Disk Drives

	Replacing a Spare
	1 Delete the spare (see Deleting a Spare on page 3�15).
	2 If the spare is in an enclosure that supports hot swapping, remove the spare disk drive and rep...
	3 If the spare is not in an enclosure that supports hot swapping, pause I/O (see Pausing I/O to a...
	4 Remove the spare and allow I/O to resume.
	5 Pause I/O again, insert the replacement drive, and allow I/O to resume.
	6 Use Adaptec CI/O Management Software to mark the new disk drive as a dedicated spare or a pool ...
	1 If the down spare is in an enclosure that supports hot swapping, remove the spare disk drive an...
	2 If the spare is not in an enclosure that supports hot swapping, pause I/O (see Pausing I/O to a...
	3 Remove the spare and allow I/O to resume.
	4 Pause I/O again, insert the replacement drive, and allow I/O to resume.
	5 Use Adaptec CI/O Management Software to mark the new disk drive as a dedicated spare or a pool ...

	Selecting a RAID Level for an Array
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